HC5500 Series
User's Manual
for Printer Driver
Notice about the law and the standard

High Speed Colour Printer
Model: HC5500T

This product contains RFID (Radio Frequency Identification) system.
Model: 444-59005

Contains FCC ID: RPARFMHL00
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The user is cautioned that unauthorised changes or modifications not approved could void the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio / TV technician for help.

Contains Canada IC: 4819A-RFMHL00
Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Countries of intended use
Austria/Belgium/Denmark/Finland/France/Germany/Greece/Iceland/Ireland/Italy/Luxembourg/Netherlands/Norway/Portugal/Spain/Sweden/Switzerland/U.K.

Copyright © 2006 RISO KAGAKU CORPORATION
Welcome to the world of this product!
This machine is an ink jet printer for high-speed full-colour printing that supports network. This printer allows various functions such as data output and printer monitoring to be used from Windows and Macintosh computers.

The following three manuals are provided for this machine.
• HC5500 Series User's Manual for Printer Main Body
• HC5500 Series User's Manual for Printer Driver (this manual)
• HC5500 Series User's Manual for Console
• RISO HC5500 Navigation Book

Before using this machine or when something is not clear during use, read the relevant manual to make good use of this machine for a long period.

About This User's Manual
Riso shall not be responsible for any damage or expense that might result from the use of this manual. As we are constantly improving our products, the machine may differ in some respects from the illustrations used in this manual. Riso shall not be liable for any direct, incidental, or consequential damages of any nature, or losses or expenses resulting from the use of this product or included manuals.

Trademark Acknowledgments
Adobe®, Adobe Type Manager®, AdobePS®, ATM®, PostScript®, PostScript® 3™, PostScript logo, and PageMaker® are trademarks or registered trademarks of Adobe Systems Incorporated. AppleTalk®, Macintosh® and Mac OS® are registered trademarks of Apple Computer, Inc. in the U.S.A. and other countries. Windows® is a registered trademark of Microsoft Corporation in the U.S.A. and other countries. ColorTune® is a trademark of Agfa-Gevaert N.V. registered at US Patent and Trademark Office and may be registered in other regions of jurisdiction. ComColor™, and FORCEJET™ are trademarks of RISO KAGAKU CORPORATION. is a registered trademark of RISO KAGAKU CORPORATION in Japan and other countries. All other product names and company names written in this manual are trademarks or registered trademarks of their respective companies.

About the Manuals
The following manuals are supplied with this machine.
• HC5500 Series User's Manual for Printer Main Body
This manual explains notes that should be known before starting operation of this machine, actual printing operation on the printer, and printer settings. This manual also explains the method of replacing consumables and troubleshooting.
• HC5500 Series User's Manual for Printer Driver
Means this manual. This manual explains the method of installing the printer and the installation procedure and the functions of the printer driver.
• HC5500 Series User's Manual for Console
This manual describes the "Monitoring" function that is used for checking the printer status through a network.
• RISO HC5500 Navigation Book
Explains useful functions and features in colour.
The following symbols and words are used in this manual for description of functions, operation, and notes.

⚠️ indicates items that should be noted or that are prohibited.

🚀 indicates description concerning particularly useful information or information that should be known.

📖 indicates a title and page that should be referred to for understanding sufficiently an item. For referring to another operation manual, the name of the manual is also written.

⚠️WARNING and ⚠️CAUTION are cautions for safety. "Safety Precautions" are described in the User’s Manual for Printer Main Body. Be sure to read these items before using this machine.

Description for the name of finisher (option)
A "Finisher" is used for description of a common matter by all finishers that are connectable to this machine. The peculiar name is used in description depending on the finisher's model.
Connecting to a Computer

The machine is connected to a computer through network.

- When connecting the machine to multiple computers:

- When connecting the machine to a single computer:

The allowable voltage for all input/output connections is 5V.

Use a commercially available S/UTP cable (shielded or non-shielded twisted pair cable) as a LAN cable.
Installation of Software

The supplied RISO Controller Software CD-ROM includes the following software. Install the software into your computer before using this machine.

The software can be used in the following environment.

<table>
<thead>
<tr>
<th>RISO Controller HC3R-5000</th>
<th>RISO Controller PS7R-9000/5000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 (SP2 or later)</td>
<td>Windows 2000 (SP2 or later)</td>
</tr>
<tr>
<td>Windows XP (SP1 or later)</td>
<td>Windows XP (SP1 or later)</td>
</tr>
<tr>
<td></td>
<td>Mac OS 9.2/Mac OS X 10.2.6 - 10.4</td>
</tr>
</tbody>
</table>
* If you use an earlier version, upgrade the operating system.

- **Printer Driver**
  This software is the printer driver of this machine that is needed to send original data created in the computer to this machine for printing. When sending original data to this machine, you can set the print conditions with the printer driver.

  If you install the RISO Controller PS7R-9000 or PS7R-5000 printer driver on Windows, an existing PS printer driver may be overwritten and a PS printer or an image setter supplied by another company may not be used for output. To delete the PS7R printer driver, use the supplied CD-ROM to uninstall it.

- **RISO IP Setting Tool**
  This software is required for setting the IP address of this machine. Before installing the printer driver, you must install this software to set the IP address of this machine.

  - Do not connect more than one machine of HC5500 when the IP address is not set (IP address is 0.0.0.0) to the same network.
  - Do not set an IP address of a different segment from the computer to which IP Setting Tool is installed.

- **IP Address**
  The IP address is unique information that is assigned to each device for identification of devices on a network. For the IP address assigned to this machine, ask the network administrator.

- **RISO Wakeup Tool**
  This software is used to restore the printer from the sleep mode so that printing can be executed from a computer (print mode ON).
Setting of Consumables

When using this machine for the first time, you must load paper and ink cartridges into this machine in advance.

● Loading Paper

● Setting Ink Cartridge
  "Ink Cartridge Replacement" of "HC5500 User's Manual for Printer Main Body"  p.3-18
Chapter 1 Installing Software .......................... 1-1

Describes the method of installing the printer driver for this machine.

RISO Controller HC3R-5000 for Windows ............................................................... 1-2
  Installing RISO IP Setting Tool ................................................................. 1-2
  Network Setting ......................................................................................... 1-4
  Installing the Printer Driver ................................................................. 1-6
  Uninstalling the Printer Driver ......................................................... 1-8
RISO Controller PS7R-9000/5000 for Windows ............................................... 1-9
  Installing RISO IP Setting Tool ............................................................. 1-9
  Network Setting ..................................................................................... 1-11
  Installing the Printer Driver ............................................................. 1-13
  Uninstalling the Printer Driver .......................................................... 1-15
RISO Controller PS7R-9000/5000 for Macintosh (Mac OS 9) ....................... 1-16
  Installing RISO IP Setting Tool ............................................................. 1-16
  Network Setting ..................................................................................... 1-18
  Installing Adobe PS .................................................................................. 1-19
  Installing the Printer Driver ............................................................. 1-20
  Select a Post Script Printer ................................................................. 1-21
  Installing ATM ......................................................................................... 1-22
RISO Controller PS7R-9000/5000 for Macintosh (Mac OS X) ....................... 1-23
  Installing RISO IP Setting Tool ............................................................. 1-23
  Network Setting ..................................................................................... 1-25
  Installing the Printer Driver ............................................................. 1-26
Installing RISO Wakeup Tool (Common to RISO Controller HC3R-5000 and
PS7R-9000/5000) ......................................................................................... 1-29

Chapter 2 Printer Driver Operations for HC3R-5000 . . . 2-1

Describes the settings of the printer driver that can be made through [Properties] in the [Print] di-
alog box.

Printer Driver Actions ............................................................................... 2-2
  Description of Screens ........................................................................... 2-2
Main setting .............................................................................................. 2-5
  Colour mode .......................................................................................... 2-5
  Original image ....................................................................................... 2-6
  Duplex printing ...................................................................................... 2-6
  Paper feed tray ..................................................................................... 2-7
  Paper type ............................................................................................. 2-7
  Ejection mode ......................................................................................... 2-8
  Pause after a proof (Proof Copy) .......................................................... 2-8
  Output mode ......................................................................................... 2-9
Layout ....................................................................................................... 2-11
  Original size ......................................................................................... 2-12
  Output paper size .................................................................................. 2-12
  Zoom ..................................................................................................... 2-12
  Orientation ........................................................................................... 2-13
Chapter 3 Printer Driver Operations for PS7R-9000/5000  . . . . 3-1

Describes the settings of the printer driver that can be made through [Properties] in the [Print] dialog box.

- Printer Driver Actions .......................................................... 3-2
  Description of Screens ......................................................... 3-2
- Main setting ........................................................................ 3-5
  Colour mode ........................................................................ 3-5
  Original image ....................................................................... 3-6
  Duplex printing ...................................................................... 3-6
  Paper feed tray ..................................................................... 3-7
  Paper type ............................................................................ 3-7
  Ejection mode ........................................................................ 3-8
  Pause after a proof (Proof Copy) ........................................... 3-8
  Output mode .......................................................................... 3-9
- Layout .................................................................................. 3-11
  Original size .......................................................................... 3-12
  Output paper size .................................................................. 3-12
  Zoom .................................................................................... 3-12
  Orientation ............................................................................ 3-13
  Pagination ............................................................................ 3-14
  Pages per sheet ...................................................................... 3-16
  Page order ............................................................................ 3-16
  Output Face .......................................................................... 3-17
- Image processing ................................................................. 3-18
  Gamma control ...................................................................... 3-18
  Screening ............................................................................... 3-20
  Special setting ........................................................................ 3-22
- Options .................................................................................. 3-26
  Job separation ........................................................................ 3-26
  Print density ........................................................................... 3-27
  Security print .......................................................................... 3-27
- Watermark ............................................................................ 2-28
  Specify the page ..................................................................... 2-28
  Add ......................................................................................... 2-28
  Edit ......................................................................................... 2-29
  Delete ...................................................................................... 2-29
- Environment ......................................................................... 2-30
  Printer config. ....................................................................... 2-31
  Custom size entry .................................................................... 2-31
- About...................................................................................... 2-34
Chapter 4 Operation of Finisher Functions for Both of HC3R and PS7R

This chapter is the common contents which are not related to the model of controller.

If an optional Finisher is installed, the [Finisher] tab is displayed on the printer driver setting screen. This chapter describes the settings of the Finisher functions.

Finisher
- Add cover
- Booklet
- Stapler
- Punching
- Output Tray
- Offset Output
- Paper Fold

Chapter 5 Troubleshooting

Describes measures against driver or utility installation failure and trouble in printing.

Troubleshooting for installing
Trouble in Printing
Other Trouble

Chapter 6 Appendix

Font List (For RISO Controller PS7R-9000/5000)
Index
Chapter 1  Installing Software

This chapter describes the method of installing the printer driver for this machine. According to your environment, install the printer driver before using this machine. After installation is complete, check the environment settings of the Printer Driver.  p.2-30  p.3-35
Before using the printer, install and set the software in the following order.

Install RISO IP Setting Tool. p.1-2

Use RISO IP Setting Tool to set the IP address of the printer. p.1-4

Install the printer driver. p.1-6

- Install RISO IP Setting Tool only onto the computer that is used for setting the IP address of the printer.
- Install the printer driver onto all the computers that use the printer.

**Installing RISO IP Setting Tool**

Install the software for setting the IP address of the printer from a computer.

RISO IP Setting Tool can also be started directly from the CD-ROM.

"Network Setting" p.1-4

1. Insert the RISO Controller HC3R Software CD-ROM into the CD-ROM drive of the computer.
   
The Installer starts. If not, double-click the "setup.exe" file in the CD-ROM.

2. Click the language which you want to display.

3. Click [Install RISO IP Setting Tool].

4. Click the [Next] button.
5 Read the License Agreement and click the [Yes] button.

6 Click the [Start] button.

7 Check that [Yes] is selected and click the [Finish] button.
   To set the IP address of this machine now, select [Yes].
   If you do not set the IP address of the printer now, select [No] and then click the [Finish] button.

8 Click [Quit].
   The Installer exits.

Installation of RISO IP Setting Tool is now complete. Then, specify the IP address of the printer.
If [Yes] is selected, RISO IP Setting Tool starts. Follow the instructions of step 2 and after of “Network Setting” (p.1-4).
Network Setting

Start RISO IP Setting Tool and set the IP address of the printer.

- If you set the IP address continuously after installing RISO IP Setting Tool, start with step 2.
- To run RISO IP Setting Tool from the RISO Controller HC3R Software CD-ROM, insert the CD-ROM into the computer and click [Execute RISO IP Setting Tool from CD]. Then start with step 2.

⚠️ Before starting the following operation, be sure to connect the printer to the computer. "Connecting to a Computer" p.iv

1. Select [Start], [Programs], [RISO HC3R], and [RISO IP Setting Tool] in this order.

2. Check that the information of the printer is displayed and click it.
   The information is highlighted.
   If the information of the printer is not displayed, check the connection between the printer and the computer. "Connection with Computer" p.iv

3. Click the [Network Configuration] icon.
   Alternatively, select [Network Configuration] from the [Settings] menu.

4. Click the [Yes] button.

5. Input the IP address to assign to the printer and click the [OK] button.
   For the IP address of the printer, ask the network administrator.

6. Click the [OK] button.

7. Press the Sleep Key of the printer and then press it again.

8. Select [File] and [Exit].
9 Click the [Yes] button.

IP address setting of the printer is now complete. After the printer starts, the IP address that has been set in step 5 becomes effective.
Then, install the printer driver. Refer to "Installing the Printer Driver" (p.1-6).
Installing the Printer Driver

- Install the printer driver onto all the computers that use the printer.
- Before installing the printer driver, set the IP address of the printer.
  "Network Setting" p.1-4

1. Insert the RISO Controller HC3R Software CD-ROM into the CD-ROM drive of the computer.
   The Installer starts. If not, double-click the "setup.exe" file in the CD-ROM.

2. Click the language which you want to display.

3. Click [Printer driver setup].

4. Click the [Next] button.

5. Read the License Agreement and click the [Yes] button.

6. Click the name of the printer to install.
   The name is highlighted.

7. Click the [Next] button.

8. Select the protocol.
   Select the protocol used for the network print.
   If you use IPP for printing, data is encrypted through SSL and sent to the printer. For printing with security, use the IPP port.
9 Click the [Next] button.

10 Input the IP address of the printer at "IP address" or click the information of the printer displayed in "Search result list."

Input the IP address that has been assigned in step 5 of "Network Setting" (p.1-4).

You can register a "broadcast address" by clicking the [Settings] button. To register a "broadcast address," enter the IP address and click the [Add] button. If there are multiple "broadcast addresses," click the desired "broadcast address" to select it and click the [OK] button to use the address. To delete an unnecessary address, click the address to select it and click the [Delete] button.

11 Click the [Register] button.

12 Click the [Install] button.

13 Click the [Finish] button.

If you place a checkmark at [Start console after completion], you can start the RISO Console after completing installation.

14 Click [Quit].

Installation of the printer driver is now complete. You can execute printing from the computer.
Uninstalling the Printer Driver

To delete (uninstall) the printer driver, follow the procedure below.

1. Follow steps 1 to 3 of "Installing the Printer Driver" (p.1-6).

2. Click the [Uninstall] button.

3. Click the printer to delete so that the printer is highlighted.
   Select the printer that has been installed onto the computer.

4. Click the [Uninstall] button.

5. Click the [Yes] button.
   The computer restarts. After the computer restarts, the printer driver is deleted completely.
Before using the printer, install and set the software in the following order.

- **Install RISO IP Setting Tool.** p.1-9
- **Use RISO IP Setting Tool to set the IP address of the printer.** p.1-11
- **Install the printer driver.** p.1-13

- Install RISO IP Setting Tool only onto the computer that is used for setting the IP address of the printer.
- Install the printer driver onto all the computers that use the printer.

### Installing RISO IP Setting Tool

Install the software for setting the IP address of the printer from a computer.

RISO IP Setting Tool can also be started directly from the CD-ROM. "Network Setting" p.1-11

1. **Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.**
   The Installer starts. If not, double-click the "setup.exe" file in the CD-ROM.

2. **Click the language which you want to display.**

3. **Click [Install RISO IP Setting Tool].**

4. **Click the [Next] button.**
1-10

5 Read the License Agreement and click the [Yes] button.

6 Click the [Start] button.

7 Check that [Yes] is selected and click the [Finish] button.
   If you do not set the IP address of the printer now, select [No] and then click the [Finish] button.

Installation of RISO IP Setting Tool is now complete. Then, specify the IP address of the printer.
If [Yes] is selected, RISO IP Setting Tool starts. Follow the instructions of step 2 and after of “Network Setting” (p.1-11).
If [No] is selected, proceed to step 8.

8 Click [Quit].

The Installer exits.
Start RISO IP Setting Tool and set the IP address of the printer.

- If you set the IP address continuously after installing RISO IP Setting Tool, start with step 2.
- To run RISO IP Setting Tool from the RISO Controller PS7R Software CD-ROM, insert the CD-ROM into the computer and click [Execute RISO IP Setting Tool from CD]. Then start with step 2.

Before starting the following operation, be sure to connect the printer to the computer.
"Connecting to a Computer" p.iv

1 Select [Start], [Programs], [RISO PS7R], and [RISO IP Setting Tool] in this order.

2 Check that the information of the printer is displayed and click it.
The information is highlighted.
If the information of the printer is not displayed, check the connection between the printer and the computer.
"Connection with Computer" p.iv

3 Click the [Network Configuration] icon.
Alternatively, select [Network Configuration] from the [Settings] menu.

4 Click the [Yes] button.

5 Input the IP address and Default Gateway to assign to the printer and click the [OK] button.
For the IP address of the printer, ask the network administrator.
If you click the [Settings] button without inputting the gateway, a message screen is displayed.

6 Click the [OK] button.

7 Press the Sleep Key of the printer and then press it again.
8 Select [File] and [Exit].

9 Click the [Yes] button.

IP address setting of the printer is now complete. After the printer starts, the IP address that has been set in step 5 becomes effective. Then, install the printer driver. Refer to "Installing the Printer Driver" (3:p.1-13).
Installing the Printer Driver

- Install the printer driver onto all the computers that use the printer.
- Before installing the printer driver, set the IP address of the printer. "Network Setting" p.1-11

1. Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.

   The Installer starts. If not, double-click the "setup.exe" file in the CD-ROM.

2. Click the language which you want to display.

3. Click [Printer driver setup].

4. Click the [Next] button.

5. Read the License Agreement and click the [Yes] button.

6. Click the name of the printer to install.

   The name is highlighted.

7. Click the [Next] button.

8. Select the protocol.

   Select the protocol used for the network print. If you use IPP for printing, data is encrypted through SSL and sent to the printer. For printing with security, use the IPP port.
9 Click the [Next] button.

10 Input the IP address of the printer at "IP address" or click the information of the printer displayed in "Search result list."

Input the IP address that has been assigned in step 5 of "Network Setting" (p.1-11).

You can register a "broadcast address" by clicking the [Settings] button. To register a "broadcast address," enter the IP address and click the [Add] button. If there are multiple "broadcast addresses," click the desired "broadcast address" to select it and click the [OK] button to use the address. To delete an unnecessary address, click the address to select it and click the [Delete] button.

11 Click the [Register] button.

12 Click the [Install] button.

13 Click the [Finish] button.

If you place a checkmark at [Start console after completion], you can start the RISO Console after completing installation.

14 Click [Quit].

Installation of the printer driver is now complete. You can execute printing from the computer.
Uninstalling the Printer Driver

To delete (uninstall) the printer driver, follow the procedure below.

1. Follow steps 1 to 3 of "Installing the Printer Driver" (p.1-13).

2. Click the [Uninstall] button.

3. Click the printer to delete so that the printer is highlighted.
   Select the printer that has been installed onto the computer.

4. Click the [Uninstall] button.

5. Click the [Yes] button.

The computer restarts. After the computer restarts, the printer driver is deleted completely.
Before using the printer, install and set the software in the following order.

1. Install RISO IP Setting Tool only onto the computer that is used for setting the IP address of the printer.
2. Install the printer driver onto all the computers that use the printer.

Installing RISO IP Setting Tool

Install the software for setting the IP address of the printer from a computer.

- RISO IP Setting Tool can also be started directly from the CD-ROM.
  "Network Setting" p.1-18

1. Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.
2. Double-click the [OS 9] and [SETUP] files in the CD-ROM.
3. Click the language which you want to display.
4. Click [Install RISO IP Setting Tool].
5 Click the [Next] button.

6 Read the License Agreement and click the [Yes] button.

7 Click the [Start] button.

8 Check that [Yes] is selected and click the [Finish] button.
   To set the IP address of this machine now, select [Yes].
   If you do not set the IP address of the printer now, select [No] and then click the [Finish] button.

   Installation of RISO IP Setting Tool is now complete. Then, specify the IP address of the printer.
   If [Yes] is selected, RISO IP Setting Tool starts. Follow the instructions of step 2 and after of “Network Setting” (p.1-18).

9 Click [Quit].

   The Installer exits.
Network Setting

Start RISO IP Setting Tool and set the IP address of the printer.

- If you set the IP address continuously after installing RISO IP Setting Tool, start with step 2.
- To run RISO IP Setting Tool from the RISO Controller PS7R Software CD-ROM, insert the CD-ROM into the computer and click [Execute RISO IP Setting Tool from CD]. Then start with step 2.

Before starting the following operation, be sure to connect the printer to the computer.
"Connecting to a Computer" p.iv

1 Select [RISO PS7R] and [ADMIN] created in the startup disk in this order and click [PS7RADMIN].

2 Check to see the information of the printer is displayed and click it.
The information is highlighted.
If the information of the printer is not displayed, check the connection between the printer and the computer.
"Connection with Computer" p.iv

3 Click the icon shown in the illustration.
Alternatively, select [Network Configuration] from the [Settings] menu.

4 Click the [Yes] button.

5 Input the IP address to assign to the printer and click the [OK] button.
For the IP address of the printer, ask the network administrator.

6 Click the [Yes] button.

7 Press the Sleep Key of the printer and then press it again after a while.

8 Select [File] and [Exit].
9 Click the [OK] button.

IP address setting of the computer is now complete. After the printer starts, the IP address that has been set in step 5 becomes effective. Then, install the printer driver. Refer to "Installing the Printer Driver" (⇒ p.1-20).

Installing Adobe PS

If Adobe PS is not installed in the computer or if the version of your Adobe PS driver is earlier than Ver. 8.7.0, use the supplied CD-ROM to perform the following operation.

If you install the Adobe PS driver (Ver. 8.8.0) supplied in the CD-ROM, a PS printer or an image setter supplied by another company may not be used for printing. For the compatibility of the Adobe PS driver to printers manufactured by other companies, contact each manufacturer.

1 Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.

2 Select [OS 9] - [Adobe PS] - [Desired language to display] from the CD-ROM in this order and double-click Adobe PS Installer of the desired language.

3 Follow the instructions on the screen to install Adobe PS.
Installing the Printer Driver

• Install the printer driver onto all the computers that use the printer.
• Before installing the printer driver, set the IP address of the printer. "Network Setting" p.1-18

1 Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.

2 Double-click the [OS 9] and [SETUP] files in the CD-ROM.

3 Click the language which you want to display.

4 Click [Printer driver setup].

5 Read the License Agreement and click the [Agree] button.

6 Select [PS7R Printer driver plug-in] and click the [Install] button.

If a message prompting to close application software, save any necessary data, close application software, and click the [Continue] button. If the installation destination disk can be selected from several disks, click the [Drive] button and select the disk in which Mac OS 9 has been installed.

7 Click the [Quit] button.

Installation of the printer driver is now complete.
Select a Post Script Printer

After installing the printer driver, select and configure the PPD(PostScript Printer Description) file of HC5500.

If Adobe PS is not installed in the computer or if the version of your Adobe PS driver is earlier than Ver. 8.7.0, use the supplied CD-ROM to install Adobe PS and then select the printer.

"Installing Adobe PS" ⇒ p.1-19

1 Select [Chooser] from the [Apple] menu.

The [Chooser] dialog box appears.
Click [Adobe PS], [RISO_PS7R] is displayed.

2 Select a printer.

Select [RISO_PS7R], click the [Create] button.


When the printer icon is created on the desktop, close the Chooser.
You can execute printing from the computer.

To use [General PPD] of RISO Controller PS7R, install it following the procedure below.
   System Folder / Extension / Printer Descriptions
2) Select [P7H7*GP.ppd] in the Chooser.
   Set the printer description file to [P7H7*GP.ppd] on the print setting screen of the application and then execute printing.
   * : A display changes which display languages chosen when installing a printer driver.

What is General PPD?

This PPD is used for printing from PageMaker and so on from which general printer drivers cannot be used for printing, or for printing from applications that call directly PPD.
Although fewer functions can be used than general printer drivers, this PPD can be used for a wide use.
Installing ATM

ATM (Adobe Type Manager) is software that displays correctly PS (PostScript) fonts installed in the hard disk of the printer controller on the display of the computer. When using ATM fonts, you can check the image close to the finished image on the display of the computer.

1. **Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.**

2. **Select [OS 9] - [ATM] from the CD-ROM in this order and double-click [ATM4.6.2 Installer].**

3. **Follow the instructions on the screen to install the software.**
   When installation is complete, ATM can be used.
Before using the printer, install and set the software in the following order.

1. Install RISO IP Setting Tool. [p.1-23]

2. Use RISO IP Setting Tool to set the IP address of the printer. [p.1-25]

3. Install the printer driver. [p.1-26]

- Install RISO IP Setting Tool only onto the computer that is used for setting the IP address of the printer.
- Install the printer driver onto all the computers that use the printer.

## Installing RISO IP Setting Tool

Install the software for setting the IP address of the printer from a computer.

RISO IP Setting Tool can also be started directly from the CD-ROM. "Network Setting" [p.1-25]

1. Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.

2. Double-click the [OS X] and [SETUP] files in the CD-ROM.

3. Click [Install RISO IP Setting Tool].

4. Click the [Next] button.
5 Read the License Agreement and click the [Yes] button.

6 Click the [Start] button.

7 Check that [Yes] is selected and click the [Finish] button.

To set the IP address of this machine now, select [Yes].
If you do not set the IP address of the printer now, select [No] and then click the [Finish] button.

8 Click [Quit].

The Installer exits.

Installation of RISO IP Setting Tool is now complete. Then, specify the IP address of the printer.
If [Yes] is selected, RISO IP Setting Tool starts. Follow the instructions of step 2 and after of "Network Setting" (p.1-25).
Network Setting

Start RISO IP Setting Tool and set the IP address of the printer.

- If you set the IP address continuously after installing RISO IP Setting Tool, start with step 2.
- To run RISO IP Setting Tool from the RISO Controller PS7R Software CD-ROM, insert the CD-ROM into the computer and click [Execute RISO IP Setting Tool from CD]. Then start with step 2.

Before starting the following operation, be sure to connect the printer to the computer.
"Connecting to a Computer"  p.iv

1 Select [RISO PS7R] and [ADMIN] created in the startup disk in this order and click [PS7RADMIN].

2 Check to see the information of the printer is displayed and click it.
   The information is highlighted.
   If the information of the printer is not displayed, check the connection between the printer and the computer.
   "Connection with Computer"  p.iv

3 Click the icon shown in the illustration.
   Alternatively, select [Network Configuration] from the [Settings] menu.

4 Click the [Yes] button.

5 Input the IP address to assign to the printer and click the [OK] button.
   For the IP address of the printer, ask the network administrator.

6 Click the [Yes] button.

7 Press the Sleep Key of the printer and then press it again after a while.

8 Select [File] and [Exit].
9 Click the [OK] button.

IP address setting of the computer is now complete. After the printer starts, the IP address that has been set in step 5 becomes effective. Then, install the printer driver. Refer to “Installing the Printer Driver” (p.1-26).

Installing the Printer Driver

- Install the printer driver onto all the computers that use the printer.
- Before installing the printer driver, set the IP address of the printer.

1 Insert the RISO Controller PS7R Software CD-ROM into the CD-ROM drive of the computer.

2 Double-click the [OS X] and [SETUP] files in the CD-ROM.

3 Click [Printer driver setup].

4 Input a [Name] and [Password] on the [Authenticate] screen and click the [OK] button.

5 Click the [Continue] button.

6 Read the License Agreement and click the [Continue] button.
7 Click the [Agree] button.

8 Select the installation destination disk and click the [Continue] button. Normally, select the startup disk.

9 Click the [Install] button.

10 Click the [Close] button.


- The location of the [Print Center] folder depends on the version of Mac OS X. This section shows an example of Mac OS X 10.2.2 for explanation.
- For Mac OS X 10.3 or 10.4, double-click [Print and Fax] in the [Applications] - [System Configuration] folder in the Mac OS Startup Disk.

12 Click the [Add] icon.

13 Select "AppleTalk" and "Local AppleTalk Zones."

14 Select "RISO KAGAKU CORPORATION" from "Printer Model."
15 Click the name of the printer to install.

16 Click the [Add] button.

17 Check that the printer is added in the printer list.

Installation of the printer driver is now complete. You can perform printing function from the computer.
Installing RISO Wakeup Tool (Common to RISO Controller HC3R-5000 and PS7R-9000/5000)

When the printer is in the sleep mode and printing cannot be executed, "RISO Wakeup Tool" can be used from a computer to restore the printer to the operational state. This section describes the installation for RISO Controller HC3R-5000 as an example. The display may vary depending on the controller.

For Windows users
Installation of RISO Wakeup Tool is not required.

1 Insert the RISO Controller HC3R Software CD-ROM into the CD-ROM drive of the computer.
   If you use a Macintosh computer, double-click [OS9] (or [OS X]) - [SETUP] in the RISO Controller PS7R Software CD-ROM.

2 Click the language to install.

3 Click [Install RISO Wakeup Tool].

4 Click the [Next] button.

5 Read the License Agreement and click the [Yes] button.

6 Select the folder in which the software is installed and click the [Next] button.
7 Click the [Next] button.

8 Click the [Start] button.

9 Click the [Finish] button.

10 Click [Quit].

11 Select [RISO] - [RISO Controller] - [RISO Wake Up Tool] created in the startup disk in this order and double-click [Wake Up].

12 Click the [Yes] button.

13 Select the controller to register and click the [OK] button.

14 Click the [Exit] button.

Installation of RISO Wakeup Tool and registration of the printer are now complete.

When installation of RISO Wakeup Tool is complete, register the controller.

When the printer is in the sleep mode or RISO Console cannot be displayed on the computer, start "RISO Wakeup Tool" and click the [Start] button.
Chapter 2  Printer Driver Operations for HC3R-5000

For printing according to your personal specifications and use, you must adjust the printer driver settings. This chapter describes the settings of the printer driver for HC3R-5000.
This section describes the settings of the printer driver.

Description of Screens

The driver setting screen consists of the following seven tabs (eight tabs if an optional HC Finisher is installed). (The screen of a Windows computer and the printer driver of UK English is used as an example here.)

[Main setting] tab
Switching between colour and monochrome, paper type, output method, etc. can be set. "Main Setting" p.2-5

[Layout] tab
Enlargement/reduction ratio in printing and the method of pagination can be set. "Layout" p.2-11

[Image processing] tab
Image quality of photos etc. can be adjusted. "Image processing" p.2-18
**[Finisher] tab**
If configuration of the finisher is set on the [Environment] tab, finisher functions can be set (only if an optional HC Finisher is installed).

"Chapter 4 Operation of Finisher Functions for Both of HC3R and PS7R" p.4-1

- The screen varies according to the model of finisher connected.

**[Options] tab**
Method of job separation, print density, and security print can be set.

"Options" p.2-26

**[Watermark] tab**
A character string that has been registered is printed as a watermark on printed images.

"Watermark" p.2-28

**[Environment] tab**
The IP address of this machine can be set, and the equipment configuration can be checked.
You can display this by clicking [Start], selecting [Printer and Faxes], and opening [Properties] of HC5500.

- The screen varies according to the model of finisher connected.
[About..] tab
The version information of the printer driver is displayed.
"About.." on p.2-34
Switching between colour print and monochrome print, paper type, output method, etc. can be set.

Settings

Colour mode
Selects colour or monochrome printing.

Original image
Selects image or character to which priority is given in printing.

Duplex printing
Selects whether or not to perform duplex printing. If duplex printing is selected, the binding position can be selected.

Paper feed tray
Selects the feed tray in which paper to be used for printing is set.

Paper type
Selects the paper type.

Ejection mode
Selects whether to perform collated printing or non collated printing.

Colour mode

Selects colour or monochrome printing. The initial setting is [Colour].

Settings

Colour
The documents are printed with colour (using 4 inks CMYK).

Monochrome
The documents are printed with black (using the black ink only).

- If "Monochrome" is selected for printing from a colour original, monochrome printing is performed.
- For colour printing, the original must be created with colour data.
**Original image**

Selects line or photo to which priority is given in printing. The optimum colour management is obtained according to the selected mode. The initial setting is [Photo-based].

**Settings**

<table>
<thead>
<tr>
<th>Line-based</th>
<th>Photo-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters and illustrations are clearly printed.</td>
<td>Images such as photos are printed with natural colour tone.</td>
</tr>
</tbody>
</table>

**What is Colour Management?**

While in the displays such as monitor, colours are expressed with "additive primary colours" (RGB: red, green, and blue), in the printers with ink, colours are expressed with "subtractive primaries" (CMY: cyan, magenta, and yellow). Since the number of colours that can be expressed with CMY is smaller than with RGB, colours on the monitor cannot be printed quite the same. For natural reproduction of colour tones, some conversion technique from RGB to CMY is required. This system of conversion is called colour management. The rules of conversion vary with the manufacturer, and each manufacturer uses its original conversion table (colour profile).

In colour management of HC5500, some kinds of colour profiles are automatically selected according to the combination of the original image and the paper type to be used to express the optimum colours.

Colour profiles created and edited with the ColorTune® technology licensed from Monotype Imaging K.K are used.

**Duplex printing**

Selects whether or not to perform duplex printing. When performing duplex printing, select the binding position.

**Settings**

<table>
<thead>
<tr>
<th>OFF (initial setting)</th>
<th>Short edge binding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplex printing is not performed.</td>
<td>Duplex printing is performed.</td>
</tr>
<tr>
<td>Long edge binding</td>
<td>The short edge of the original becomes the binding position.</td>
</tr>
<tr>
<td>Duplex printing is performed.</td>
<td></td>
</tr>
<tr>
<td>The long edge of the original becomes the binding position.</td>
<td></td>
</tr>
</tbody>
</table>

- If you select [Booklet] at [Pagination] on the [Layout] tab, [Short edge binding] is automatically selected for [Duplex printing].
- When you perform printing onto paper placed in a tray for which [Paper type] on the [Main setting] tab is set to [Envelope], duplex printing is not available.
Paper feed tray

Selects the paper feed tray in which paper to be used for printing is loaded.

**Settings**

**Auto tray selection**
The paper feed tray is automatically selected according to the settings of [Paper type] on the [Main setting] tab and [Output paper size] on the [Layout] tab.

**Feed Tray 1**
Printing is performed onto the paper loaded in Paper Feed Tray 1.

**Feed Tray 2**
Printing is performed onto the paper loaded in Paper Feed Tray 2.

**Standard Feed Tray**
Printing is performed onto the paper loaded in the Standard Paper Feed Tray.
- If Feed Tray 1/Feed Tray 2/Standard Feed Tray is selected, printing is performed onto the paper loaded in the selected paper feed tray regardless of the settings of [Paper type] on the [Main setting] tab and [Output paper size] on the [Layout] tab.
- If no specific feed tray meets the condition set at [Tray Selection Rule], an error will occur and therefore printing cannot be performed. Check the setting in the menu setting of the printer.

Paper type

Selects the paper type. In printing, ink quantity adjustment and image processing adequate for the selected paper type are performed.

**Selectable paper types**
- Standard 1
- High-Quality 1
- High-Quality 2
- Envelope
- Card Stock
- Card-IJ

- If the selected paper type is different from the paper types set for the feed trays and the Standard Feed Tray and [Tray Selection Rule] of the menu setting of the printer is set to [Size & Type], an error occurs and printing cannot be performed. The paper types of the feed trays and the Standard Feed Tray are set on the Operation Panel of the printer.
  "Menu4 Configuration" of "HC5500 User’s Manual for Printer Main Body" (p.2-18)
  "Menu5 Administration" of "HC5500 User’s Manual for Printer Main Body" (p.2-31)
- If the relevant paper type is not included in the list, specify the equivalent type. When not specified, no-paper error occurs and printing cannot be performed.
  "Environment" (p.2-30)
- When printing onto an envelope, be sure to set [Paper type] to [Envelope]. If a different paper type is set, an envelope may jam in the printer or the print head may be damaged.
- If you select Envelope as Paper type, the image is automatically rotated by 180 degrees before printing.
  "Printing onto Envelope" of “HC5500 User’s Manual for Printer Main Body” (p.1-21)
Ejection mode

Selects whether to perform collated printing or non collated printing. The initial setting is [Collate].

Pause after a proof (Proof Copy)

When printing a lot of pages or printing a lot of copies, you can check the print by printing only one page or one set first (not included in the specified number of copies). After checking, if no problem is found, press the PRINT/PAUSE key on the printer to continue printing. If adjustment of the print position or anything in relation is required, you can adjust the setting on the printer. The initial setting is off (no check mark).

If [Ejection mode] is set to [Non collate], proof copy is printed for a page. If [Collate] is set, one set is printed.

"Ejection mode" p.2-8
"Menu 1 Print Position Adjust" of "HC5500 User’s Manual for Printer Main Body” p.2-13
Output mode

Selects whether to print data sent from the computer, to store it in the storage or to store it as a form in the printer.

**Settings**

Direct print (initial setting)
Prints data immediately onto paper that is transmitted from a computer.

Storage

**Specify output condition**

A stored output setting can be selected. Also the storage folder to which output data is stored can be specified and a job comment can be input.
Click the [Specify output condition] button to display the [Specify output condition] screen.

**Settings**

Output condition
You can select whether to print according to the printer driver setting or to print according to output setting stored in your PC.
When printing according to the printer driver setting, select [Printer driver setting].
When printing according to setting stored in your PC, select the desired setting in the pull-down menu and click the [OK] button.
The initial setting is [Printer driver setting].

- You can store the "Output condition" in your PC by "Output setting" button.
- If the printer is not connected to a network, "Connecting to Server..." is displayed.

Job comment
You can input a comment to be displayed in the [Details] screen of [Job Manager].
Up to 128 characters can be entered.
"Forms" of "HC5500 User's Manual for Console"

Print & Storage
Performs direct printing and also stores the output data in the printer controller (Storage).

**Storage folder name**

Output data can be stored in any folder created in the printer.
If [Print & Storage] or [Storage] is selected at [Output mode] and folders are created in the printer, select one of folder1 - folder9 (or any registered foldername that has been set).
Select the desired folder in the pull-down menu and click the [OK] button.
The initial setting is [Folder 0].

- If the printer is not connected to a network, "Connecting to server..." is displayed.
The current printer driver settings can be stored in your PC and up to 20 sets of settings can be stored. This function is useful for printing repeatedly with the same settings. Stored settings can be selected for direct printing from [Main setting] tab - [Specify output condition] - [Output condition] of the printer driver. Click the [Output setting] button to display the [Output setting] screen.

The following conditions cannot be saved by [Output setting]. Specify them again when printing the documents.

- "Security code" of security print in "Options" tab.
- The items in "Watermark" tab.

### Settings

**Name**
Input a name for stored printer driver settings. Up to 32 characters can be input.

**Output condition**
Currently stored settings are displayed.

**Save**
Click to save the current printer driver settings in your PC.

**Delete**
Click to delete unnecessary output settings. Select the settings to delete and click the [Delete] button.

**Close**
Click to close the screen without storing the current printer driver settings.
Sets the enlargement/reduction ratio in printing and the method of pagination.

- **Settings**
  - **Original size**
    Selects the paper size specified with the application software.
  - **Output paper size**
    Selects the paper size for printing.
  - **Zoom**
    Sets the image enlargement/reduction ratio in printing.
  - **Orientation**
    Selects the orientation of original for printing.
  - **Pagination**
    Selects the type of pagination. Depending on the type of pagination, detailed settings to be displayed vary.
  - **Pages per sheet**
    Selects the number of pages per sheet for pagination.
  - **Output face**
    Selects whether or not prints are output with the first page face down.
  - **Default**
    Returns the settings on the [Layout] tab to the default settings.
  - **Help**
    Displays Help.
**Original size**

Selects the paper size that is specified with the application software. The initial setting is [A4].
The following paper sizes can be selected.
* Paper sizes that have been registered in advance with [Custom size entry] in [Environment] tab are displayed.

- If you use frequently irregular sizes, register the sizes in advance. These sizes can be easily selected from the pull-down menu. The registered paper sizes are also displayed as [Output Paper Size].
  "Controller setting 2" of "HC5500 User's Manual for Console"  p.2-17
- If you do not register the size and you specify each time, use the following procedure.
  1. Select [Custom] at [Original size] and click the [Custom Paper Entry] button.
  2. Input the original size*.
     Width: 90mm to 316mm (3 3/16" to 12 2/16")
     Length: 148mm to 460mm (5 13/16" to 18 1/8")
  3. Close the printer driver screen.
  4. Register the paper size using the menu setting of the printer.
  5. Start the application software for creating the original.
  6. Input the paper size that has been input in step 2, at [Paper size] of [Page Set up].

* When a finisher is connected to the printer, usable paper sizes vary according to the model of finisher. See below.

**Output paper size**

Selects the paper size for printing. The initial setting is [Same as original].
The following paper sizes can be selected.
Same as original/ A3W(*1) / A3 / A4 / B4 / B5 / B6 / Postcard / Foolscap / Legal / Letter / Tabloid / Statement / Custom / Custom size 1-20 (*2)
*1 The A3W size is 316 mm (W) x 460 mm (L).
*2 Paper sizes that have been registered in advance with [Custom size entry] in [Environment] tab are displayed.

If [Zoom] is not set (not checked), for an original size different from the output paper size, enlargement/reduction is automatically performed according to the output paper size.
If you use frequently irregular sizes or if you specify an irregular size each time, use the same operation as [Original Size] described above.

When a finisher is connected to the printer, usable paper sizes vary according to the model of finisher.
HC Finisher: width 100mm-316mm  length 148mm-460mm
HC Auto Stacker: width 100mm-305mm  length 148mm-432mm

**Zoom**

Specifies the enlargement/reduction ratio for printing in %.
If you click [Zoom] to display a check mark, you can specify the enlargement/reduction ratio from 50% to 200%.
The initial setting is off.

- If [Pagination] is set to any of [Multi-up (Single page)], [Multi-up (Multi-page)], [Booklet], and [Fold], Zoom cannot be specified.
Orientation

Selects the orientation of original for printing. Select Portrait or Landscape according to the setting in application. The initial setting is [Portrait].

Depending on the application, the orientation set in the application does not operate properly with the setting of the printer driver for this machine. Check the orientation of the paper set in the machine and set the correct orientation in the printer driver.
**Pagination**

Selects the type of pagination.

**Settings**

**OFF (initial setting)**
Pageation is not performed.

**Multi-up (Single page)**
A multiple number of same page are paginated onto a sheet. The number of pages per sheet can be set at [Pages per sheet].

**Multi-up (Multi-page)**
A multiple number of continuous pages are paginated onto a sheet in the page order. The number of pages per sheet can be set at [Pages per sheet]. The order can be set at [Page order].

**Booklet**
A multiple number of continuous pages are paginated and printed onto two sides so that a booklet can be obtained by binding at the centre. Two pages are printed on each side of paper.

The direction of page order can be set at [Reverse order (from right to left)] under [Page order] on the [Layout] tab.

- If [Booklet] is selected, [Duplex printing] on the [Main setting] tab is automatically set to [Long edge binding]. If [Duplex printing] is set to [OFF] or [Short edge binding], this setting is set to [OFF].
- Any page with no print data becomes blank.
- If [Booklet] of the optional Finisher functions is set to an item other than [OFF], this setting is automatically enabled.
- Printing is performed so that the first page (cover) is output last.

**Poster print**
An original is enlarged, and divided images are printed onto multiple sheets of paper. By joining these multiple sheets, you can make a large print such as a poster. Set the number of divided images at [Divided number].

- If [Booklet] is selected, [Duplex printing] on the [Main setting] tab is automatically set to [Long edge binding]. If [Duplex printing] is set to [OFF] or [Short edge binding], this setting is set to [OFF].
- Any page with no print data becomes blank.
- If [Booklet] of the optional Finisher functions is set to an item other than [OFF], this setting is automatically enabled.
- Printing is performed so that the first page (cover) is output last.
Pages per sheet (Divided number)

If [Multi-up (Single page)] or [Multi-up (Multi-page)] is selected at [Pagination], set the number of pages per sheet for pagination. Any of 2, 4 and 8 pages/sheet can be selected. The initial setting is 2 pages.

If [Booklet] is selected at [Pagination], the number of pages per sheet need not be selected. The number is automatically set.

If you select [Poster Print] at [Pagination], set the number of sheets for division. You can select 4 or 9 sheets. The initial setting is 4.

By clicking the [Detail] button and selecting [Print registry guides], you can print register marks that can be used as reference for jointing the paper.

By clicking a number displayed in the preview, you can print the part that corresponds to the selected number.

Page order

If [Multi-up (Multi-page)] is selected at [Pagination], select the arrangement of pages.
If [Booklet] or [Fold] is selected at [Pagination], select the direction of arrangement of pages. If [Reverse order (from right to left)] is not checked, the direction is left to right, and if checked, the direction is right to left.

Settings

**Vertical**
Pages are arranged in the vertical order sequentially.

**Horizontal**
Pages are arranged in the horizontal order sequentially.

Reverse order (from right to left)
Selects the direction of arrangement of pages. If [Booklet] or [Fold] is selected at [Pagination], select the direction of arrangement of pages.
Output Face

Selects whether or not prints are output with the first page face down.

**Settings**

**Auto**
The output face is automatically determined according to the setting of [Ejection mode] on the [Main setting] tab.

**Facedown**
Prints are output with the first page face down. When two or more jobs are printed continuously, the printed documents are ejected in the same order which received data.

If [Paper type] on the [Main setting] tab is set to [Envelope], [Facedown] cannot be selected.
Image processing

Specifies print quality for image materials such as photo.

![Image processing settings](image)

**Settings**

**Gamma control**
Adjusts the Gamma values of Lightness, Chroma, Contrast and RGB.

**Screening**
Selects the method of half-tone processing.

**Screen frequency (lpi)**
If [Dot screen] is selected at [Screening], select the screen frequency.

---

**Special setting**
Sets the orientation of the original, print position, image quality, etc.

**Default**
Returns the settings on the [Image processing] tab to the default settings.

**Help**
Displays Help.

---

**Gamma control**

Adjusts the Gamma values of Lightness, Chroma, Contrast and RGB.

**About Gamma Value...**

This means density of half tone in display and printing. The value is set for each unit of equipment such as computer and printer (2.2 for Windows computer, 1.8 for Macintosh, 1.8 for printer). If the brightness between the image displayed on the screen of a computer and the printed image is different, adjust this value.
**Settings**

**Lightness**
Adjust the lightness of images among 51 levels (-25 to +25). Higher lightness makes whitish images and lower lightness makes blackish images. The initial setting is standard (0).

![Lightness Examples](image)

**Chroma**
Adjust the clarity of images among 51 levels (-25 to +25). Higher chroma makes clearer images and lower chroma makes cloudier images. The initial setting is standard (0).

![Chroma Examples](image)

**Contrast**
Adjust the contrast (correlation between brightness and darkness) of images among 51 levels (-25 to +25). High contrast increases the difference between bright areas and dark areas, resulting in sharper images. Low contrast decreases the difference between the brightness and darkness, resulting in greyish images on the overall area. The initial setting is standard (centre).

![Contrast Examples](image)
Details

Adjusts the Gamma value for each colour of RGB.
Click [Details] to display a check mark and click the [Change details] button to display the [Gamma control Details change] window.
You can click ▲ or ▼ to adjust the value from -25 to +25.
A smaller value makes lighter images and a larger value makes darker images.
The initial setting is 0.

This item is different from the general concept of Gamma control.
☞ p.2-18
Screening

Sets the half-tone processing method and enables/disables line smoothing.

What is Half Tone?
Half tone is a method of processing for expressing continuous colour tones with the limited number of ink types by changing the density and size of ink discharged onto sheet.

Selectable processing methods
The method of half-tone processing can be selected from two types.

Error diffusion (initial setting)
Expresses tones with dot density. Higher density makes darker images, and lower density makes lighter images.

Dot screen
Expresses tones by adjusting the size of dot. A larger size makes darker images, and a smaller size makes lighter images.
Line smoothing

Sets whether or not to enable line smoothing. If this item is checked, line smoothing is enabled which results in the outlines of characters and ruled lines printing smoothly. The initial setting is off.

⚠️ If line smoothing is used, print time increases.

What is Line Smoothing?
This function suppresses serrated outlines of characters and images which results in high resolution of printed quality. This function complements the outlines with a more defined colour between the drawing and background colours.

![Example of line smoothing](image)

Screen frequency (lpi)

If [Screening] is set to [Dot screen], set the number of dot lines (resolution). 70 lpi and 100 lpi can be selected. 100 lpi makes finer images.

The initial setting is 70 lpi.

"Screening" p.2-21
Special setting

Adjusts the orientation of original, print position, image quality, etc.

Settings

Image rotation
Sets the orientation of the original.

Image position adjustment
Adjusts the print position of the original.

Image quality
Sets the quality (resolution) of printing.
Image rotation

Sets the orientation of original printing which is in relation to the paper. Auto/0 degree/90 degrees/180 degrees/270 degrees can be selected. If [Auto] is selected, the orientation of printing is automatically selected based on the orientation of the original set in data, the orientation of the paper set in the feed tray is ready for use.
The initial setting is [Auto].

⚠️ Depending on the original size and the size and orientation of the paper in the feed tray, rotation of 90 degrees may be unavailable.

Image position adjustment

Adjusts the print position. The position can be adjusted in the vertical and horizontal directions from −20mm to 20mm (−13/16" to +13/16") in 0.5mm (0.02") increments. For duplex printing, the position can be adjusted on the front and back sides respectively.
Image quality

Sets the image quality (resolution). Standard (300dpi x 300dpi) or Fine (300dpi x 600dpi) can be selected. The initial setting is [Standard (300dpi x 300dpi)].
Sets the method of job separation, print density, and security print.

**Options**

Sets the method of job separation, print density, and security print.

### Settings

- **Job separation**
  Sets the timing of separation paper insertion.
- **Print density**
  Sets the print density.
- **Security print**
  Protects a job for printing with the security function.

#### Default

Returns the settings on the [Options] tab to the default settings.

#### Help

Displays Help.

### Job separation

Inserts job separation paper between jobs and sets or pages when printing multiple jobs or copies.

- Set the feed tray used for job separation paper on the Operation Panel of the printer in advance.
  "5.3 Separation Paper" of "HC5500 User's Manual for Printer Main Body"  p.2-36
- You can change the setting on the Operation Panel of the printer.
  "4.6 Job Separation" of "HC5500 User's Manual for Printer Main Body"  p.2-23
- If an optional HC Finisher is connected, you can use this function with the functions of the HC Finisher: Punching, Add cover.

#### Settings

- **OFF** (initial setting)
  Job separation is not performed.
- **Every division**
  Inserts automatically separation paper each time a unit of collated printing or non collated printing is complete.
  Set collate or non collate at [Ejection mode] on the [Main setting] tab. "Ejection mode" p.2-8
- **Between jobs**
  Job separation paper is automatically inserted between jobs.
Print density

Adjusts the print density. The density can be adjusted among five levels from Level 1 (light) to Level 5 (Dark). A larger value means darker printing. The initial setting is Level 3 (standard).

After proof copy, you can adjust the density on the Operation Panel of the printer.

"4.7 Print Density" of "HC5500 User's Manual for Printer Main Body"  p.2-24

Security print

When printing a confidential document or a document that should not be read by other persons, you can set a security code for printing a job. Click the [Security] button to display the [Security Print] screen.

If a job for which security is set is sent from a computer, the job is not immediately printed and is put in the waiting state. Instruct to output the job from the console or the touch panel display for printing.

Settings

**Security Code (0 - 8 digits)**
A security code for a job is set with 0 to 8 numeric characters.
To output or delete a job for which a security code has been set from the job manager, you must input the security code.

**Job name is not indicated on Job Manager.**
If you place a checkmark, the job name is not displayed in Job status regardless of the setting of [Job information display].

The job name is not displayed either in the job manager screen for administrator regardless of the setting of [Administrator] of RISO Console HC3R.

- A job for which Security print is set can be output only if [Output mode] is set to [Direct print] or [Storage].
- A job for which Security print is set is not retained in the printer even if a checkmark is placed at [Keep the last page of the job in the printer.] in [Controller setting 2] - [Initial setting] of [Administrator] of RISO Console HC3R.
- All jobs from computers including jobs for which Security print is set can be put in the waiting state without printing immediately. Also jobs in the waiting state can be automatically deleted.

"HC5500 Series User's Manual for Console" "Security print setting"  p.2-17
A character string that has been registered is printed as a watermark on printed images.

![Watermark settings window](image)

**Settings**

**Specify the page**
Specifies the page on which a watermark is added in printing.

- **Add**
  Adds a character string for a watermark.

**Edit**
Sets character decoration and print position for a watermark.

**Delete**
Deletes a character string that has been added with [Add].

### Specify the page

Specifies the page on which a watermark is printed.

**Settings**

- **OFF**
  No watermark is printed.

- **All page**
  A selected watermark is printed on all pages.

- **First page only**
  A watermark is printed only on the first page.

**Add**

 Adds a character string for a watermark.
 Click the [Add] button to display the input window.
 You can input the characters up to 63 characters.
Edit

Sets character decoration and print position for a watermark. Select the character on the [Watermark] tab and click the [Edit] button.

Settings

Character string
The selected character string is displayed.

Font
Fonts installed in the computer are displayed.

Font size
Sets the font size.

Colour
The character string colour can be selected from Black, Grey, Red, Green, Blue, Cyan, Magenta, Yellow, and Custom. If you click the [Detail] button, the colour palette of OS is displayed.

Transparency
Sets the level of transparency of a character string. Higher transparency results in more transparent characters for easy-to-see original images.

Frame
The frame for a watermark can be selected from None, Circle, Rectangle, and Double rectangle.

Character angle
The character string angle can be selected from Horizontal (0 deg), Vertical (90 deg), Vertical (270 deg), Oblique (45 deg), Oblique (315 deg), and Custom (0 - 360 deg).

Print position
Selects the character string print position. The position can be selected from Center, Upper left, Upper center, Right center, Lower right, Lower center, Lower left, Left center, and Custom. The position can be adjusted finely in the X and Y axis respectively. The position can also be adjusted with mouse operation in the preview.

The coordinates to be adjusted as print position indicate the center of the character string.

Delete

Deletes a character string that has been added as a watermark. Select the watermark to delete and click the [Delete] button.
Environment

Allows the configuration of options connected to this machine to be set and irregular sizes of paper to be registered in the printer driver.
You can display this by selecting [Control Panel] - [Printer and Faxes] and opening [Properties] of HC5500 on the computer.

The items that will be displayed vary according to the model of finisher connected.

Settings

Printer config.
The installation status and the types of options connected to this machine are displayed. This item can be set manually.

Custom size entry
Up to 20 irregular sizes of paper can be registered in the printer driver.

Default
Returns the settings on the [Environment] tab to the default settings.

Help
Displays Help.

Apply
The settings are reflected into the printer.
Printer config.

The connection state of options is displayed. When an option is added, the configuration can be set manually.

**Settings**

**Multi tray paper feeder**
Sets whether or not the multi tray paper feeder is installed.
If [Not installed] is set, only the Standard Feed Tray can be used.

**Finisher/Basic unit**
Sets whether or not the HC Finisher unit is installed and sets the type of the unit (2/4 punching holes or 2/3 punching holes).
Selects [Installed (Auto Stacker)], when HC Auto Stacker is connected to your printer.

**Finisher/Booklet maker unit**
Sets whether or not the Booklet maker unit of the HC Finisher is installed.

**Finisher / Folder unit**
Sets this item to [Not installed].

**Single side print + staple -> Speed priority**
If the HC Finisher is installed, you can increase the processing speed for stapling in single side printing by setting this item to [ON].
However, stapling is performed from the back side to the front side.

**Additional engine memory**
Sets whether or not the printer memory is added and sets the capacity of the additional memory if added. Normally, set 512MB.

**Paper category**
Sets whether the paper type to be used is displayed for the Japanese market or the other areas.

**A unit of length**
Sets mm or inch.

---

**Custom size entry**

Registers custom paper sizes in the printer driver. The sizes registered here are displayed as "Registered Paper Sizes 1 - 20" as original sizes and output paper sizes.

![Custom size entry](image)

- Up to 20 sizes can be registered.
**Settings**

**Width**
You can input the paper width between 100mm-316mm.

**Length**
You can input the paper length between 148mm-460mm.

---

**Name**
You can name the paper size that will be registered. Up to 32 characters can be input.

**Add**
Registers the custom size to the printer driver. Click it after inputting the paper size and the name.

**Delete**
Deletes a custom size that has been registered.

**Export**
Stores a registered paper size in the specified folder so that other users on the network can use the size.

**Import**
Recalls a registered size stored in the shared folder.

---

**How to register**

1. **Click the [Custom size entry] button.**
The Custom size entry screen is displayed.

2. **Input the size and the name to register.**

3. **Click the [Add] button.**

4. **To share the registered paper size with other users on the network, click the [Export] button.**

5. **Specify the storage location.**
Click the [Close] button.

To use a paper size stored in the folder on the network, select the desired paper size in the [Custom size entry] screen and click the [Import] button.
The version of the printer driver installed in the computer can be checked.

**Settings**

**Version**
Version of printer driver

**Colour profile**
Version of colour profile

**Model name**
Model name of the printer
For printing according to your personal specifications and use, you must adjust the printer driver settings. This chapter describes the settings of the printer driver for PS7R-9000/5000.
This section describes the settings of the printer driver.

Description of Screens

The driver setting screen consists of the following eight tabs (nine tabs if an optional HC Finisher is installed). (The screen of a Windows computer and the printer driver of UK English is used as an example here.)

[Main setting] tab
Switching between colour and monochrome, paper type, output method, etc. can be set. "Main Setting" p.3-5

[Layout] tab
Sets the enlargement/reduction ratio in printing and the method of pagination. "Layout" p.3-11

[Image processing] tab
Image quality for photo or anything in relation can be adjusted. "Image processing" p.3-18
[Finisher] tab
Finisher functions can be set if an optional HC Finisher is installed.
"Chapter 4 Operation of Finisher Functions for Both of HC3R and PS7R" p.4-1

The screen varies according to the model of finisher connected.

[Options] tab
Method of job separation, print density, clustering and security print can be set.
"Options" p.3-25

[Forms] tab
A form registered in the printer can be overlaid on output data for printing.
"Forms" p.3-29

[Environment] tab
The IP address of this machine can be set, and the equipment configuration can be checked.
On Windows 2000/XP, you can display this by clicking [Start], selecting [Printer and Faxes], and opening [Properties] of HC5500.
On Mac OS 9/X, the [Environment] tab is displayed on the printer driver setting screen.
"Environment" p.3-35

The screen varies according to the model of finisher connected.
[Advanced] tab
The PostScript printer driver setting screen is displayed. Use with the default settings is recommended.

[About..] tab
The version information of the printer driver is displayed. "About.."@p.3-37
Main setting

Switching between colour print and monochrome print, paper type, output method, etc. can be set.

Settings

**Colour mode**
Selects colour or monochrome printing.

**Original image**
Selects image or character to which priority is given in printing.

**Duplex printing**
Selects whether or not to perform duplex printing. If duplex printing is selected, the binding position can be selected.

**Paper feed tray**
Selects the feed tray in which paper to be used for printing is set.

**Paper type**
Selects the paper type.

**Ejection mode**
Selects whether to perform collated printing or non collated printing.

Colour mode

Selects colour or monochrome printing. The initial setting is [Colour].

**Settings**

**Colour**
The documents are printed with colour (using 4 inks CMYK).

**Monochrome**
The documents are printed with black (using the black ink only).

- If "Monochrome" is selected for printing from a colour original, monochrome printing is performed.
- For colour printing, the original must be created with colour data.

Pause after a proof
Sets whether or not to output proof copy.

Output mode
Selects the output mode of data sent from the computer. The current setting is displayed below.

Specify output condition
Selects a registered output setting and a storage folder name.

Default
Returns the settings on the [Main setting] tab to the default settings.

Help
Displays Help.
**Original image**

Selects line or photo to which priority is given in printing. The optimum colour management is obtained according to the selected mode. The initial setting is [Photo-based].

**Settings**

<table>
<thead>
<tr>
<th>Line-based</th>
<th>Photo-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters and illustrations are clearly printed.</td>
<td>Images such as photos are printed with natural colour tone.</td>
</tr>
</tbody>
</table>

**What is Colour Management?**

While in the displays such as monitor, colours are expressed with "additive primary colours" (RGB: red, green, and blue), in the printers with ink, colours are expressed with "subtractive primaries" (CMY: cyan, magenta, and yellow). Since the number of colours that can be expressed with CMY is smaller than with RGB, colours on the monitor cannot be printed quite the same. For natural reproduction of colour tones, some conversion technique from RGB to CMY is required. This system of conversion is called colour management. The rules of conversion vary with the manufacturer, and each manufacturer uses its original conversion table (colour profile).

In colour management of HC5500, some kinds of colour profiles are automatically selected according to the combination of the original image and the paper type to be used to express the optimum colours.

Colour profiles created and edited with the ColorTune® technology licensed from Monotype Imaging K.K are used.

---

**Duplex printing**

Selects whether or not to perform duplex printing. When performing duplex printing, select the binding position.

**Settings**

- **OFF** *(initial setting)*
  - Duplex printing is not performed.

- **Long edge binding**
  - Duplex printing is performed.
  - The long edge of the original becomes the binding position.

- **Short edge binding**
  - Duplex printing is performed.
  - The short edge of the original becomes the binding position.

- If you select [Booklet] at [Pagination] on the [Layout] tab, [Short edge binding] is automatically selected for [Duplex printing].

- When you perform printing onto paper placed in a tray for which [Paper type] on the [Main setting] tab is set to [Envelope], duplex printing is not available.
Paper feed tray

Selects the paper feed tray in which paper to be used for printing is loaded.

**Settings**

**Auto tray selection**
The paper feed tray is automatically selected according to the settings of [Paper type] on the [Main setting] tab and [Output paper size] on the [Layout] tab.

**Feed Tray 1**
Printing is performed onto the paper loaded in Paper Feed Tray 1.

**Feed Tray 2**
Printing is performed onto the paper loaded in Paper Feed Tray 2.

**Standard Feed Tray**
Printing is performed onto the paper loaded in the Standard Paper Feed Tray.

- If Feed Tray 1/ Feed Tray 2/ Standard Feed Tray is selected, printing is performed onto the paper loaded in the selected paper feed tray regardless of the settings of [Paper type] on the [Main setting] tab and [Output paper size] on the [Layout] tab.
- If no specific feed tray meets the condition set at [Tray Selection Rule], an error will occur and therefore printing cannot be performed. Check the setting in the menu setting of the printer.

Paper type

Selects the paper type. In printing, ink quantity adjustment and image processing adequate for the selected paper type are performed.

**Selectable paper types**

- Standard 1
- High-Quality 1
- High-Quality 2
- Envelope
- Card Stock
- Card-IJ

- If the selected paper type is different from the paper types set for the feed trays and the Standard Feed Tray and [Tray Selection Rule] of the menu setting of the printer is set to [Size & Type], an error occurs and printing cannot be performed. The paper types of the feed trays and the Standard Feed Tray are set on the Operation Panel of the printer.
  - “Menu4 Configuration” of “HC5500 User’s Manual for Printer Main Body” (p.2-18)
  - “Menu5 Administration” of “HC5500 User’s Manual for Printer Main Body” (p.2-31)
- If the relevant paper type is not included in the list, specify the equivalent type. When not specified, no-paper error occurs and printing cannot be performed.
  - “Environment” (p.3-35)
- When printing onto an envelope, be sure to set [Paper type] to [Envelope]. If a different paper type is set, an envelope may jam in the printer or the print head may be damaged.
Ejection mode

Selects whether to perform collated printing or non collated printing. The initial setting is [Collate].

- If [Pause after a proof] is enabled, proof copy is printed in the ejection mode specified here. 
  “Pause after a proof” p.3-8
- When using "Collate" function, be sure to clear the checkmark at [Collate] or [Collated] in the Print dialog box displayed by the application software. 
  “Trouble in Printing” p.5-3

Pause after a proof (Proof Copy)

When printing a lot of pages or printing a lot of copies, you can check the print by printing only one page or one set first (not included in the specified number of copies). After checking, if no problem is found, press the PRINT/PAUSE key on the printer to continue printing. If adjustment of the print position or anything in relation is required, you can adjust the setting on the printer. The initial setting is off (no check mark).

- If [Ejection mode] is set to [Non collate], proof copy is printed for a page. If [Collate] is set, one set is printed. 
  “Ejection mode” p.3-8
  “Menu 1 Print Position Adjust” of "HC5500 User’s Manual for Printer Main Body" p.2-13
Output mode

Selects whether to print data sent from the computer, to store it in the storage or to store it as a form in the printer controller.

- **Settings**

  **Direct print (initial setting)**
  Prints data immediately onto paper that is transmitted from a computer.

  **Archive**
  Output data that is processed with RIP is stored (archived) in the printer controller.
  The stored data can be selected on the [Archive] tab in [Job manager] of RISO Console PS7R for repeated printing.
  Since the data is processed with RIP, the output conditions cannot be changed but the data can be printed in a shorter time than "Direct print" or "Storage."

  - Output to "Archive" and the Security print cannot be used together at the same time. p.3-28
  - If HC5500 is used as a network printer, the Security print cannot be set for data that will be stored into "Archive."
  - Consequently, data stored in "Archive" can be accessed freely by users through RISO Console. It is recommended not to output (store) secret documents into "Archive."
  - Consequently, note that if an HC Finisher is connected and "Save except cover in archive" of the "Booklet" function is selected, the security function is not applied to data stored in "Archive."

  **Storage**
  Stores the output data in the printer controller. Data stored in the storage can be printed repeatedly by selecting it on the [Storage] tab of [Job manager] of RISO Console PS7R.

  **Print & Storage**
  Performs direct printing and also stores the output data in the printer controller (Storage).

  **Form**
  Stores the output data as a form in the printer controller.
  The stored form can be selected on the [Forms] tab and be overlaid on other output data for printing.
  Output data created by overlay with a form cannot be stored in the storage.
Specify output condition

A registered output setting can be selected if [Output mode] is not set to [Form]. Also the storage folder to which output data is stored can be specified and a job comment can be input.

Click the [Specify output condition] button to display the [Specify output condition] screen.

Settings

Output condition

You can select whether to print according to the printer driver setting or to print according to output setting registered in the printer controller.

When printing according to the printer driver setting, select [Printer driver setting].

When printing according to setting registered in the printer controller, select one of Direct 1 - Direct 9 (or any registered name that has been set).

Select the desired setting in the pull-down menu and click the [OK] button.

The initial setting is [Printer driver setting].

- Register output setting to the printer in [Administrator] of the Console.
  "Direct Output Setting" of "HC5500 User's Manual for Console" p.2-20
- If the printer is not connected to a network, "Connecting to Server..." is displayed.

Folder security code

If you select [Storage] or [Print & Storage] at [Output mode] and store the data in a folder for which a security code is set, input the security code.

- The security code for a folder is set at [Administrator] - [Folder setting] of RISO Controller PS7R.
- In a folder for which a security code is set, data can be stored only if the correct security code is input.
- If the security code is not correct, the data is stored in folder 0. The stored data cannot be output. (The data can be deleted only.)

Job comment

You can input a comment to be displayed in the [Details] screen of [Job Manager].

Up to 128 characters can be entered.

Storage folder name

Output data can be stored in any folder created in the printer controller.

If [Print & Storage] or [Storage] is selected at [Output mode] and folders are created in the printer controller, select one of folder1 - folder9 (or any registered folder-name that has been set).

Select the desired folder in the pull-down menu and click the [OK] button.

The initial setting is [Folder 0].

- Create folders in [Administrator] of the Console.
  "Folder Setting " of "HC5500 User's Manual for Console" p.2-22
- If the printer is not connected to a network, "Connecting to server..." is displayed.
Sets the enlargement/reduction ratio in printing and the method of pagination.

Settings

**Original size**
Selects the paper size specified with the application software.

**Output paper size**
Selects the paper size for printing.

**Zoom**
Sets the image enlargement/reduction ratio in printing.

**Orientation**
Selects the orientation of original for printing.

**Pagination**
Selects the type of pagination.

**Pages per sheet**
Selects the number of pages per sheet for pagination.

**Page order**
Selects the order of arrangement of pages for pagination.

**Output face**
Selects whether or not prints are output with the first page face down.

**Default**
Returns the settings on the [Layout] tab to the default settings.

**Help**
Displays Help.
Original size

Selects the paper size that is specified with the application software. The initial setting is [A4].
The following paper sizes can be selected.

* Paper sizes that have been registered in advance with [Controller setting 2] in [Administrator] of RISO Console PS7R are displayed.

- If you use frequently irregular sizes, register the sizes in advance. These sizes can be easily selected from the pull-down menu. The registered paper sizes are also displayed as [Output Paper Size].
  "Controller setting 2" of "HC5500 User's Manual for Console"2-18
- If you do not register the size and you specify each time, use the following procedure.
  1. Select [Custom] at [Original size] and click the [Custom Paper Entry] button.
  2. Input the paper size*.
     Width: 90mm to 316mm (3\(\frac{3}{16}\)” to 12\(\frac{7}{16}\)”)
     Length: 148mm to 460mm(5\(\frac{13}{16}\)” to 18\(\frac{1}{8}\)”)
  3. Close the printer driver screen.
  4. Start the application software for creating the original.
     The original size selected in step 2 is reflected and the original can be created with the size proper for this machine.
     HC5500 connected with PS7R is a PS printer. Although the setting in the application software normally takes precedence, if an original is created for a non-standard size, the [Original size] must be input in the HC5500 printer driver in advance and therefore the steps are different from the normal procedure.

* When a finisher is connected to the printer, usable paper sizes vary according to the model of finisher. See below.

Output paper size

Selects the paper size for printing. The initial setting is [Same as original].
The following paper sizes can be selected.
Same as original / A3W(*1) / A3 / A4 / B4 / B5 / B6 / Postcard / Foolscap / Legal / Letter / Tabloid / Statement / Custom / Custom size 1-20 (*2)

*1 The A3W size is 316 mm (W) x 460 mm (L).
*2 Paper sizes that have been registered in advance with [Controller setting 2] in [Administrator] of RISO Console PS7R are displayed.

If [Zoom] is not set (not checked), for an original size different from the output paper size, enlargement/reduction is automatically performed according to the output paper size.
If you use frequently irregular sizes or if you specify an irregular size each time, use the same operation as [Original Size] described above.

When a finisher is connected to the printer, usable paper sizes vary according to the model of finisher.
HC Finisher: width 100mm-316mm length 148mm-460mm
HC Auto Stacker: width 100mm-305mm length 148mm-432mm

Zoom

Specifies the enlargement/reduction ratio for printing in %.
If you click [Zoom] to display a check mark, you can specify the enlargement/reduction ratio from 50% to 200%.
The initial setting is off.

If [Pagination] is set to any of [Multi-up (Single page)], [Multi-up (Multi-page)], [Booklet], and [Fold], Zoom cannot be specified.
Orientation

Selects the orientation of original for printing. Select Portrait or Landscape according to the setting in application. The initial setting is [Portrait].

Depending on the application, the orientation set in the application does not operate properly with the setting of the printer driver for this machine. Check the orientation of the paper set in the machine and set the correct orientation in the printer driver.
**Pagination**

Selects the type of pagination.

- **Settings**

  - **OFF (initial setting)**
    Pagination is not performed.

  - **Multi-up (Single page)**
    A multiple number of same page are paginated onto a sheet. The number of pages per sheet can be set at [Pages per sheet].

  - **Multi-up (Multi-page)**
    A multiple number of continuous pages are paginated onto a sheet in the page order. The number of pages per sheet can be set at [Pages per sheet]. The order can be set at [Page order].

  - **Booklet**
    A multiple number of continuous pages are paginated and printed onto two sides so that a booklet can be obtained by binding at the centre. Two pages are printed on each side of paper. The direction of page order can be set at [Reverse order (from right to left)] under [Page order] on the [Layout] tab.

  - **Fold**
    A multiple number of continuous pages are paginated and printed so that a book can be obtained by folding in two (crosswise) after duplex printing, binding, and cutting. Four pages are printed onto each side of a sheet. The direction of page order can be set at [Reverse order (from right to left)] under [Page order] on the [Layout] tab.

  - If [Booklet] is selected, [Duplex printing] on the [Main setting] tab is automatically set to [Long edge binding]. If [Duplex printing] is set to [OFF] or [Short edge binding], this setting is set to [OFF].

  - Any page with no print data becomes blank.

  - If [Booklet] of the optional HC Finisher functions is set to an item other than [OFF], this setting is automatically enabled.

  - Printing is performed so that the first page (cover) is output last.

  - If [Fold] is selected, [Duplex printing] on the [Main setting] tab is automatically set to [Long edge binding]. If [Duplex printing] is set to [OFF] or [Short edge binding], this setting is set to [OFF].

  - Any page with no print data becomes blank.
**Pages per sheet**

If [Multi-up (Single page)] or [Multi-up (Multi-page)] is selected at [Pagination], set the number of pages per sheet for pagination. Any of 2, 4, 8, and 16 pages/sheet can be selected. The initial setting is 2 pages.

If [Booklet] or [Fold] is selected at [Pagination], the number of pages per sheet need not be selected. The number is automatically set.

**Page order**

If [Multi-up (Multi-page)] is selected at [Pagination], select the arrangement of pages.

If [Booklet] or [Fold] is selected at [Pagination], select the direction of arrangement of pages. If [Reverse order (from right to left)] is not checked, the direction is left to right, and if checked, the direction is right to left.

**Settings**

**Vertical**
Pages are arranged in the vertical order sequentially.

**Horizontal**
Pages are arranged in the horizontal order sequentially.

**Reverse order (from right to left)**
Selects the direction of arrangement of pages. If [Booklet] or [Fold] is selected at [Pagination], select the direction of arrangement of pages.
Output Face

Selects whether or not prints are output with the first page face down.

**Settings**

**Auto**
The output face is automatically determined according to the setting of [Ejection mode] on the [Main setting] tab.

**Facedown**
Prints are output with the first page face down. When two or more jobs are printed continuously, the printed documents are ejected in the same order which received data.

- If [Paper type] on the [Main setting] tab is set to [Envelope], [Facedown] cannot be selected.
Image processing

Specifies print quality for image materials such as photo.

### Settings

**Gamma control**
Adjusts the Gamma values of contrast, density and CMYK.

**Screening**
Selects the method of half-tone processing.

**Screen frequency (lpi)**
If [Dot screen] is selected at [Screening], select the screen frequency.

### Special setting
Sets the orientation of the original, print position, image quality, etc.

### Default
Returns the settings on the [Image processing] tab to the default settings.

### Help
Displays Help.

---

**Gamma control**

Adjusts the Gamma values of contrast, density and CMYK.

**About Gamma Value...**
This means density of half tone in display and printing. The value is set for each unit of equipment such as computer and printer (2.2 for Windows computer, 1.8 for Macintosh, 1.8 for printer). If the brightness between the image displayed on the screen of a computer and the printed image is different, adjust this value.

**In the printer controller of HC5500 Series...**
Although value 1.8 makes bright images according to the general concept of Gamma control, this value can makes darker images with the printer controller of HC5500 Series.
Note that the value set at [Details] causes reverse effect of display.
**Settings**

**Contrast**
Adjust the contrast (correlation between brightness and darkness) of images among five levels. High contrast increases the difference between bright areas and dark areas, resulting in sharper images. Low contrast decreases the difference between the brightness and darkness, resulting in greyish images on the overall area. The initial setting is standard (centre).

![Contrast Examples](image)

**Density**
Adjusts the density of images with five levels. The initial setting is standard (centre).

![Density Examples](image)

**Details**
Adjusts the Gamma value for each colour of CMYK. Click [Details] to display a check mark and click the [Change details] button to display the [Gamma control Details change] window.

You can click ▲ or ▼ to adjust the value from 0.1 to 3.0.
A smaller value makes lighter images and a larger value makes darker images.
The initial setting is 1.0.

![Gamma Control Details Change](image)

This item is different from the general concept of Gamma control.

脚注
p.3-18
Screening

Sets the half-tone processing method and enables/disables line smoothing.

What is Half Tone?
Half tone is a method of processing for expressing continuous colour tones with the limited number of ink types by changing the density and size of ink discharged onto sheet.

Selectable processing methods
The method of half-tone processing can be selected from two types.

Error diffusion (initial setting)
Expresses tones with dot density. Higher density makes darker images, and lower density makes lighter images.

Dot screen
Expresses tones by adjusting the size of dot. A larger size makes darker images, and a smaller size makes lighter images.
Line smoothing

Sets whether or not to enable line smoothing. If this item is checked, line smoothing is enabled which results in the outlines of characters and ruled lines printing smoothly. The initial setting is off.

⚠️ If line smoothing is used, print time increases.

What is Line Smoothing?
This function suppresses serrated outlines of characters and images which results in high resolution of printed quality. This function complements the outlines with a more defined colour between the drawing and background colours.

Screen frequency (lpi)

If [Screening] is set to [Dot screen], set the number of dot lines (resolution). 70 lpi and 100 lpi can be selected. 100 lpi makes finer images.
The initial setting is 70 lpi.
"Screening" p.3-20

Dot screen setting

Cannot be set in HC5500 Series.
Special setting

Adjusts the orientation of original, print position, image quality, etc.

○ Settings

Image rotation
Sets the orientation of the original.

Image position adjustment
Adjusts the print position of the original.

Image quality
Sets the quality (resolution) of printing.

Auto colour matching
Sets colour matching with ComColor™ Standard.
**Image rotation**

Sets the orientation of original printing which is in relation to the paper. Auto/0 degree/90 degrees/180 degrees/270 degrees can be selected. If [Auto] is selected, the orientation of printing is automatically selected based on the orientation of the original set in data, the orientation of the paper set in the feed tray is ready for use. The initial setting is [Auto].

⚠️ Depending on the original size and the size and orientation of the paper in the feed tray, rotation of 90 degrees may be unavailable.

---

**Image position adjustment**

Adjusts the print position. The position can be adjusted in the vertical and horizontal directions from –20mm to 20mm (–13/16" to +13/16") in 0.5mm (0.02") increments. For duplex printing, the position can be adjusted on the front and back sides respectively.
Image quality

Sets the image quality (resolution). Standard (300dpi x 300dpi) or Fine (300dpi x 600dpi) can be selected. The initial setting is [Standard (300dpi x 300dpi)].

Auto colour matching

Selects whether or not to use HC5500 Series original colour management (ComColor™ Standard) for colour adjustment (conversion).

Normally, check this item (colour management is enabled).

If colour management is not required, clear the check mark. In this case, colour management depends on the setting of application that is used for creating output data. Also if the check mark is cleared, [Maximum drops] can be set manually.

⚠️ If [Maximum drops] is set to [Auto], the number of drops adequate for the paper type is automatically set. Normally, use this function with [Auto].

Settings of Maximum drops

<table>
<thead>
<tr>
<th>Auto</th>
<th>Adjusts automatically the colours.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Few</td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>(5 is standard)</td>
</tr>
<tr>
<td>6</td>
<td>Many</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ When printing data created with CMYK, clear the check mark.

If the check mark is not cleared, when data created with CMYK in application software is printed, colour adjustment (conversion) is performed and colours different from the created data are used for printing.
Options

Sets the method of job separation, print density, clustering, and security print.

- **Settings**
  - **Job separation**
    Sets the timing of separation paper insertion.
  - **Print density**
    Sets the print density.
  - **Clustering**
    Improves efficiency of printer processing by splitting or distributing jobs to other printer controllers of the same model linked through the network.
  - **Security print**
    Protects a job for printing with the security function.
  - **Default**
    Returns the settings on the [Options] tab to the default settings.
  - **Help**
    Displays Help.

### Job separation

Inserts job separation paper between jobs and sets or pages when printing multiple jobs or copies.

- Set the feed tray used for job separation paper on the Operation Panel of the printer in advance.
  - "5.3 Separation Paper" of "HC5500 User's Manual for Printer Main Body"  p.2-36
- You can change the setting on the Operation Panel of the printer.
  - "4.6 Job Separation" of "HC5500 User's Manual for Printer Main Body"  p.2-23
- If an optional HC Finisher is connected, you can use this function with the functions of the finisher: Punching, Add cover.

- **Settings**
  - **OFF (initial setting)**
    Job separation is not performed.
  - **Every division**
    Inserts automatically separation paper each time a unit of collated printing or non collated printing is complete.
    Set collate or non collate at [Ejection mode] on the [Main setting] tab. "Ejection mode"  p.3-8
  - **Between jobs**
    Job separation paper is automatically inserted between jobs.
Print density

Adjusts the print density. The density can be adjusted among five levels from Level 1 (light) to Level 5 (Dark). A larger value means darker printing. The initial setting is Level 3 (standard).

After proof copy, you can adjust the density on the Operation Panel of the printer.

“4.7 Print Density” of “HC5500 User’s Manual for Printer Main Body”  p.2-24

Clustering

When printing a lot of jobs, copies or pages, you can improve the efficiency of printer processing by splitting or distributing jobs to other printer controllers of the same model linked through the network.

Click the [Details] button to display the [Clustering] window.

For a large data size, splitting of a job will give smoother printing.

If an optional HC Finisher is installed, when you use the clustering function, turn off the following functions on the [Finisher] tab.

- The setting of [Add cover]
- The setting of [Booklet]
- The setting of [Stapler]
- The setting of [Punching]
- The setting of [Paper Fold]
- The setting of [Offset Output]

Settings

Job delegation

If multiple units of the same printer controller model are connected on the network, jobs can be distributed to these controllers.

If Job delegation is set to ON, when a new job is received while a job is being processed, the new job is sent for printing to a controller that has the highest priority is the order of the registered controller IP list. The initial setting is [OFF].

Register the controllers using [Clustering] at [Controller setting] in [Administrator] of RISO Console PS7R. Example of “Clustering” of “HC5500 User's Manual for Console” (p.2-16) is shown.

Job split

When processing a job with a lot of pages or a lot of copies, you can split the job into multiple jobs. Application loaded to the printer controller per job will be reduced.

- Output-range-based
  Set the page number that triggers job split at [Job split limit].

- Print-volume-based
  Set the number of copies that triggers job split at [Job split limit].

The initial setting is [OFF].

Job split limit

Specifies the condition for job split. If the specified number of pages or copies is exceeded, job split is activated.
Example of Job split
An example in which Job split limit is set to "100 (page)" and a job of 240 pages is processed for printing is shown.
If Print range is set to 1 - 240 page, the job is split into three jobs of 100 pages, 100 pages, and 40 pages.
Security print

When printing a confidential document or a document that should not be read by other persons, you can set a security code for printing a job. Click the [Security Print] button to display the [Security Print] screen.

If a job for which security is set is sent from a computer, the job is not immediately printed and is put in the waiting state. Instruct to output the job from the console or the touch panel display for printing.

Settings

Security Code (0 - 8 digits)
A security code for a job is set with 0 to 8 numeric characters.
To output or delete a job for which a security code has been set from the job manager, you must input the security code.

Job name is not indicated on Job Manager.
If you place a checkmark, the job name is not displayed in Job status regardless of the setting of [Job information display].

The job name is not displayed either in the job manager screen for administrator regardless of the setting of [Administrator] of RISO Console HC3R.

• A job for which Security Print is set can be output only if [Output mode] is set to [Direct print] or [Storage].
• A job for which a Security Print is set is not retained in the printer even if a checkmark is placed at [Keep the last page of the job in the printer.] in [Controller setting 2] - [Initial setting] of [Administrator] of RISO Console HC3R.
• All jobs from computers including jobs for which Security Print is set can be put in the waiting state without printing immediately. Also jobs in the waiting state can be automatically deleted.

"HC5500 Series User's Manual for Console" "Security print setting" p.2-17
A form registered in the printer can be selected for overlaying it on the output data for printing. This function is useful for printing two separate originals (separate data) onto both sides of paper respectively.

Registration of form
- Create form data in advance and register it in the printer by selecting [Form] at [Output mode] on the [Main setting] tab. Registered form file names are displayed in [Form list].
  “Registration of Form” p.3-33
- Output data overlaid on a form cannot be registered in the storage.
- Multiple forms can be registered.

Settings

Form print pattern
Sets whether or not to print a form onto the same face as output data.

Form data print face
Selects whether to print a form onto the front side or the back side in Double side overlay.

Specify Front and Back respectively
For duplex printing, two forms can be specified from the form list for the front side and the back side separately.

Form information displayed

Form list
File name of the forms registered in the printer are displayed.

Form preview
The selected form is previewed.
Form print pattern

Selects whether a form is printed onto the same face as output data (Single side overlay) or onto the reverse side (Double side overlay).

Settings

OFF
No form is printed.

Single side overlay
A form is printed onto the same face as the output data. When duplex printing is set, [Specify Front and Back respectively] can be selected. If a checkmark is placed at [Specify Front and Back respectively], [Front form] and [Back form] can be selected from the form list separately.

Double side overlay
Fixed form data is printed repeatedly onto the side specified with [Form data print face]. Output data is printed onto the other side as variable data.

Single + Double side overlay
Output data is overlaid on a form and printed onto one side, and another form is printed onto the other side.
Form data print face

If [Double side overlay] is selected at [Form print pattern], set whether to print the form data onto the front side or the back side of paper. The initial setting is [Back].
Registration of form

Forms to be used must be created in a computer in advance and be registered in the printer controller.

- If multiple page data is registered as a form, all the pages are registered but only the first page is printed as form data. Remaining data is not used for printing.
- If the paper size of form data is different from the actual paper size, the form is printed with reference to the lower left corner. (The lower left corner of the form is printed at the lower left corner of the actual paper.)

1 Create form data using a computer.

2 Select [Print] from the [File] menu of application.
   The [Print] dialog box is displayed.

3 Check that the printer is selected and click the [Properties] button.

4 Select [Form] at [Output mode] in the [Main setting] dialog box.

5 Click the [OK] button.
   The [Print] dialog box appears again.

6 Click the [OK] button.
   The data is sent to the printer and registered as a form. Registered data can be selected in [Form list] on the [Forms] tab.
How to Print a Form

1. Create output data to combine with a form and select [Print] from the [File] menu of the application.

2. Check that the printer is selected and click the [Properties] button.


4. Set the print conditions such as [Original image] and [Paper type].

5. Select [Form print pattern] on the [Forms] tab.
   If you select [Double side overlay], select also [Form data print face].

6. Click the form to print in [Form list] to select.
   The preview is displayed. Check the detail.

7. Click the [OK] button.
   The screen in step 1 appears again.

8. Click the [OK] button.
   The output data is overlaid on the form and sent to the printer.

- If multiple page data is registered as a form, all the pages are registered but only the first page is printed as form data. Remaining data will not be used for printing.
- If the paper size of form data is different from the actual paper size, the form is printed with reference to the lower left corner.
Environment

Sets the IP address assigned to this machine and allows the configuration of options connected to this machine to be checked. On Windows 2000/XP, you can display this by clicking [Start], selecting [Printer and Faxes], and opening [Properties] of HC5500. On Mac OS 9/X, the [Environment] tab is displayed on the printer driver setting screen.

The items that will be displayed vary according to the model of finisher connected.

- **Settings**

  - **Through printer server**
    Sets whether or not printing is performed through a printer server.
    
    This item can be set only on Windows 2000/XP.
  
  - **Controller IP address**
    Sets the IP address of the controller built in this machine.
    
    - Windows 2000/XP: Normally, setting is not necessary. Set this item when using this machine as a shared printer.
    - Mac OS 9/X: Be sure to set this item. Then, functions such as form printing and output setting can be used.

  - **Printer config.**
    The installation status and the types of options connected to this machine are displayed. This item can be set manually.

  - **Obtain info from printer**
    Obtains the configuration information on options from this machine. The obtained information is displayed at [Printer config.].
    
    You can click this item when [Controller IP address] has been set and normal communication with the printer is available.

  - **Make this setting default**
    Stores the current setting as the default setting.
    
    This item is displayed only on Mac OS 9/Mac OS X.

- **Default**

  Returns the settings on the [Environment] tab to the default settings.

- **Help**

  Displays Help.

- **Apply**

  The settings are reflected into the printer.
The connection state of options is displayed. When an option is added, the configuration can be set manually.

**Settings**

**Multi tray paper feeder**
Sets whether or not the multi tray paper feeder is installed.
If [Not installed] is set, only the Standard Feed Tray can be used.

**Finisher/Basic unit**
Sets the installation status of the HC Finisher unit and the type of the unit (2/4 punching holes or 2/3 punching holes).
Selects [Installed (Auto Stacker)], when HC Auto Stacker is connected to your printer.

**Finisher/Booklet maker unit**
Sets whether or not the Booklet maker unit of the HC Finisher is installed.

**Finisher/Folder unit**
Set this item to "Not installed."

**Additional engine memory**
Sets whether or not the printer memory is added and sets the capacity of the additional memory if added. Normally, set 512MB.

**Paper category**
Sets whether the paper type to be used is displayed for the Japanese market or the other areas.

**A unit of length**
Sets mm or inch.
About..

The version of the printer driver installed in the computer can be checked.

![Printer Driver Settings](image)

- **Settings**
  - **Plug-in**
    Version of plug-in
  - **Model name**
    Model name of the printer
  - **PPD file name**
    Name of PPD file installed in the computer
Chapter 4  Operation of Finisher Functions for Both of HC3R and PS7R

If an optional HC Finisher is installed, the [Finisher] tab is displayed on the printer driver setting screen. This chapter describes the settings of the Finisher functions.

For the names of parts, details of functions, method of removing jammed paper, and specifications, refer to "HC Finisher Maintenance Guide." If an optional HC Auto Stacker is connected, see "HC 5500 User's Manual for Printer Main Body".
This chapter describes the usable items for the HC Finisher. When connecting the HC Auto Stacker, only [Offset output] can be used.

This tab sets the method of adding covers, the punching/stapling positions, the method of creating booklets, etc.

Settings (for HC Finisher)

- **Add cover**
  Adds a front cover and/or a back cover to prints when outputting.

- **Booklet**
  Creates booklets by folding paper in two.

- **Stapler**
  Staples printed paper.

- **Punching**
  Punches holes in printed paper.

- **Output tray**
  Selects the tray to which prints are output.

Setting (for HC Auto Stacker)

- **Offset output**
  Outputs prints to the Stacking Tray at an offset position for each set.

- **Paper fold**
  Outputs paper that has been folded into two.

- **Default**
  Returns the settings on the [Finisher] tab to the default settings.

- **Help**
  Displays Help.
Add cover

Selects whether or not to add a cover. Select a cover to be added (front cover or back cover) and select the tray in which cover sheets are loaded.

Details of Add cover

Place a checkmark and click the [Details] button. The [Details] screen is displayed. The following paper sizes can be used for covers: A3/A4/A4-R/B4/B5/B5-R/Ledger/Legal/Letter/Letter-R

Paper that can be used for Add cover

- Paper size:

  - A3
  - A4
  - A4 R
  - B4
  - B5
  - B5 R
  - Ledger
  - Legal
  - Letter
  - Letter R

- Paper weight: For Cover Sheet Tray: 60g/m² - 220g/m² (16-lb bond to 58.7-lb bond)
  For Interposer Tray (Standard Feed Tray): 60g/m² - 210g/m² (16-lb bond to 56-lb bond)
  For Interposer Tray (Tray1/Tray2): 60g/m² - 104g/m² (16-lb bond to 28-lb bond)

- Up to 200 sheets can be loaded in the Cover Sheet Tray.
- If [Booklet] is [ON], back covers cannot be added.
- If [Separate books] is set in Details of [Booklet], either front covers or back covers cannot be added.
- The paper size that can be loaded as covers is the same as the paper size for the body of document. When setting front covers of a different size from the body of document, set the paper size of the tray (Cover Sheet Tray / Interposer Tray) to the size of [Output paper size] on the [Layout] tab of the printer driver. However, do not set [Auto].
- Irregular size paper cannot be used as a cover.
- When loading covers in the Interposer Tray, setting is required in advance.

4.1/4.2/4.3 Feed Tray" of "HC5500 User's Manual for Printer Main Body" p.2-19
4.11 Cover Sheet Tray" of "HC5500 User's Manual for Printer Main Body" p.2-30
5.3 Separation Paper" of "HC5500 User's Manual for Printer Main Body" p.2-36
**Settings**

**Put front cover**
Adds a front cover before the first page of prints when outputting paper.

**Select front cover tray**
Selects the tray in which paper for front covers is loaded.
You can select the Cover Sheet Tray of the HC Finisher or the Interposer tray that has been set on the Operation Panel of the printer.
”5.3 Separation Paper” of "HC5500 User's Manual for Printer Main Body" ☞ p.2-36

---

**Put back cover**
Adds a back cover after the last page of prints when outputting paper.

**Select back cover tray**
Selects the tray in which paper for back covers is loaded.
You can select the Cover Sheet Tray of the HC Finisher or the Interposer tray that has been set on the Operation Panel of the printer.
”5.3 Separation Paper” of "HC5500 User's Manual for Printer Main Body" ☞ p.2-36
Booklet

Creates booklets by printing continuous multiple pages with pagination and folding paper in two. Also the folding portion can be stapled.

**Settings**

**OFF (Initial setting)** 
Booklets are not made. Each sheet is output as a sheet from an original.

**Fold and staple** 
Creates booklets by folding paper in two and binding at the centre.

**Fold** 
Creates booklets by folding paper in two.

---

If [Fold] or [Fold and staple] is selected, automatically [Duplex printing] is set to [Short edge binding] and [Pagination] is set to [Booklet] on the [Main setting] tab.

**Paper that can be used for Booklet**

- **Paper size:**
  - A3
  - A4
  - B4
  - Ledger
  - Legal
  - Foolscap
  - Letter
  - Custom size
    - Paper ejection direction
      - 210mm (8 1/4") to 316mm (12 2/16")
      - 280mm (11") to 457mm (18")

- **Paper weight:** 60g/m² - 90g/m² (16-lb bond to 24-lb bond)  (up to 220g/m² [58.7-lb bond] for cover sheet)

**Maximum stapling capacity**

The capacity is 60 pages (15 sheets) in total including covers.
Details of Booklet

If you select an item other than [OFF] at [Booklet] and click the [Details] button, the [Details] screen is displayed.

Settings

Separate books
When making a booklet of 16 sheets (61 pages) or more, the Separate books setting is required.
If [Auto] is selected, for Fold and staple, a booklet is output every 60 pages (15 sheets).
For only Fold, a booklet is output every 5 sheets (20 pages). If [Setting of number of sheets] is selected, click ▼ or ▲ to set the number of sheets that form a booklet.
For “Fold and staple”, set the number from 1 to 15 sheets (60 pages). For “Fold”, set the number from 1 to 5 sheets (20 pages).
The initial setting is [OFF].

Print cover separately
Only the covers are printed separately. This function is useful for printing the covers onto paper different from paper for the body of a document.
If [Print cover only] is selected, only the pages for covers (beginning two pages and last two pages of originals) will be printed. At this time, if you click [Save except cover in storage] or [Save except cover in archive] to place a checkmark, the pages other than the covers are processed with RIP and stored into [Storage] or [Archive] of [Job manager] of RISO Console. If you load printed covers in the Cover Sheet Tray and print the body of the document by recalling from the storage or archive, you can make booklets.
If you select [Print except cover], pages other than the covers are printed as booklets.
The initial setting is [OFF].

Centre binding margin
Sets the width of the centre binding margin.
If you click [Put centre binding margin] to place a checkmark, the binding margin width can be set from 0 mm to 50 mm (0” to 2”) in 1 mm (0.04”) increments.
If you place a checkmark at [Auto reducing], any image that is not included in the image area because of the margin width will be automatically reduced so that the image is included in the image area of the paper.
The initial setting is [OFF].
Stapler

Staples printed paper at specified positions.

○ Selectable stapling positions

- OFF (initial setting)
- Left 2 positions
- Left top 1 position
- Top 2 positions
- Top left 1 position
- Top right 1 position
- Right 2 positions
- Right top 1 position

This function can be used with [Duplex printing] and [Punching].

"Punching"  p.4-9

○ Paper that can be used for stapling

- Paper size:
  - A3
  - A4 R
  - A4
  - B4
  - B5 R
  - Ledger
  - Legal
  - Foolscap
  - Letter
  - Letter R
  - Custom size
    - 203mm (8") to 297mm (111/16")
    - 182mm (73/16") to 432mm (17")

- Paper weight: 46g/m² - 210g/m² (12-lb bond to 56-lb bond) (60g/m² to 220g/m² [16-lb bond to 58.7-lb bond] for cover sheet)

○ Maximum number of sheets for stapling

- For A4, A4-R, B5-R, letter, and letter-R: 100 sheets
- For standard sizes other than those above: 65 sheets

- If the number of sheets exceeds the maximum number for stapling, printed sheets are output to the Stacking Tray without stapling.
- For paper shown below, the maximum number for stapling is 2 to 65 sheets.
  - Paper with width in the paper ejection direction of 216 mm (8½") or more
  - Paper larger than the size of 297 mm (111/16") long and 216 mm (8½") wide
Details of Stapler/Punching

If you select an item other than [OFF] at [Stapler] and click the [Details] button, the [Details] screen is displayed.

Settings

Binding margin
Sets the binding margin width.
If you click [Put binding margin] to place a checkmark, the binding margin width can be set from 0 mm to 50 mm in 1 mm increments.
If you click [Auto reducing] to place a checkmark, any image that is not included in the image area because of the margin width will be automatically reduced so that the image is included in the image area of the paper.
The initial setting is [OFF].

Punching hole
For punching, either 2 holes or 4 holes (3 holes) can be selected.
Punching

Punches holes in printed paper.
If HC Finisher A is connected, 2-hole or 3-hole punching can be made. If HC Finisher B is connected, 2-hole or 4-hole punching can be made.

 selectable punching positions

- OFF (initial setting)
- Left
- Top
- Right

This function can be used with [Duplex printing] and [Stapler].
"Stapler" p.4-7

Paper that can be punched

<table>
<thead>
<tr>
<th>Punching holes</th>
<th>Paper that can be punched</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 holes</td>
<td>A3, A4 R, B4, B5 R, Ledger, Letter R</td>
</tr>
<tr>
<td>4 holes</td>
<td>A3, A4 R, Ledger, Letter R</td>
</tr>
</tbody>
</table>

- Paper weight: 46g/m² - 157g/m² (12-lb bond to 42-lb bond) (60g/m² to 220g/m² [16-lb bond to 58.7-lb bond] for cover sheet)

Details of Stapler/Punching

If you select an item other than [OFF] at [Punching] and click the [Details] button, the [Details] screen is displayed.
"Details of Stapler/Punching" p.4-8
Output Tray

Selects the tray to which prints are output.

**Settings**

**Auto (initial setting)**

Outputs paper automatically to a proper tray according to the setting of Finisher functions.

Normally, set [Auto].

Stacking Tray

Select this tray when printing more than 500 sheets without using any Finisher functions. The paper size that can be output to the Stacking Tray is 182 mm to 330 mm x 182 mm to 488 mm (7 3/16" to 13" x 7 3/16" to 19 3/16").

(for stapling: 203 mm to 297 mm x 182 mm to 432 mm [8" to 11 11/16" x 7 3/16" to 17"])

If Paper fold or Booklet is set, the Stacking Tray cannot be selected.

Offset Output

Outputs paper at an offset position for each set when outputting paper to the Stacking Tray.

[Offset output] is a function of the Stacking Tray. This function cannot be used with a function that does not use the Stacking Tray such as the 2-fold and Booklet functions. The [Job Separation] function on the [Options] tab of the printer driver cannot be used with this function either.

**Settings**

**OFF (initial setting)**

Offset output is not performed.

**ON**

Offset output is performed.

**Paper that can be used for offset output**

<table>
<thead>
<tr>
<th>Finisher model</th>
<th>Width</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>HC Finisher</td>
<td>203mm-297mm</td>
<td>182mm-460mm *</td>
</tr>
<tr>
<td>HC Auto Stacker</td>
<td>131mm-305mm</td>
<td>148mm-432mm</td>
</tr>
</tbody>
</table>

* 182mm-432mm for staple

Paper weight: 46g/m² - 210g/m² (12-lb bond to 56-lb bond) (for cover sheet: 60g/m² to 220g/m² [16-lb bond to 58.7-lb bond])
Paper Fold

Outputs paper that has been folded into two.

**Settings**

**OFF (initial setting)**
Paper fold is not performed.

**2-fold**
Paper is folded in two.
Paper is output to the Booklet tray.

---

**Paper that can be used for Paper fold**

- **Paper size:**
  - A3
  - A4
  - B4
  - Ledger
  - Legal
  - Foolscap
  - Letter

- **Custom size:**
  - 210mm (8 1/4") to 316mm (12 7/16")
  - 280mm (11") to 457mm (18")

- **Paper weight:** 60g/m² - 90g/m² (16-lb bond to 24-lb bond)
Details of Paper Fold

If you select an item other than [OFF] at [Paper fold] and click the [Details] button, the [Details] screen is displayed.

Settings
Folding direction
Selects whether paper is folded with the print face (first page in duplex printing) inside or outside. The initial setting is [Print inside].

![Printed inside and printed outside diagrams]
Chapter 5 Troubleshooting

This chapter describes measures against driver or utility installation failure and trouble in printing.
### Troubleshooting for installing

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If RISO IP Setting Tool cannot be installed:</td>
<td>• Even if the CD-ROM is inserted into the computer, the Installer does not start. Depending on the model or setting of the computer, the Installer may not automatically start.</td>
</tr>
</tbody>
</table>
| If RISO IP Setting Tool does not operate normally: | • RISO IP Setting Tool is not installed properly. Refer to the page shown below to install again RISO IP Setting Tool.  
  - RISO Controller HC3R-5000 for Windows .......................... p.1-2  
  - RISO Controller PS7R-9000/5000 for Windows .................. p.1-9  
  - RISO Controller PS7R-9000/5000 for Mac OS 9 ............... p.1-16  
  - RISO Controller PS7R-9000/5000 for Mac OS X ............... p.1-23  
  - Even if RISO IP Setting Tool is started, printer information is not displayed.  
    - Click the [Search] icon to update the displayed information.  
    - Ensure that the printer is turned on.  
    - Ensure that the printer is connected to the computer.  
      "Connection with Computer" p.iv |
| If the printer driver cannot be installed: | • The IP address of the printer is not set. Refer to the page shown below to assign the IP address to the printer.  
  - RISO Controller HC3R-5000 for Windows .......................... p.1-4  
  - RISO Controller PS7R-9000/5000 for Windows .................. p.1-11  
  - RISO Controller PS7R-9000/5000 for Mac OS 9 ............... p.1-18  
  - RISO Controller PS7R-9000/5000 for Mac OS X ............... p.1-25  
  • An incorrect IP address is specified. (Windows only)  
    The IP address that has been input when you install the printer driver is not correct. Input the correct IP address. p.1-6 |
## Trouble in Printing

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing takes a long time.</td>
<td>A checkmark is displayed at &quot;Collate&quot; in the [Print] dialog box of application software. Clear the checkmark in the [Print] dialog box of the application software and set [Ejection mode] on the [Main setting] tab in the printer driver screen.</td>
</tr>
<tr>
<td>Collated printing or non collated printing cannot be performed.</td>
<td>Clear the checkmark in the [Print] dialog box of the application software and set [Ejection mode] on the [Main setting] tab in the printer driver screen.</td>
</tr>
<tr>
<td>Printing with the specified printing conditions cannot be performed.</td>
<td>If you use Excel, set [Ejection mode] on the [Main setting] tab in the printer driver screen and then clear the checkmark at [Collate] in the [Print] dialog box.</td>
</tr>
</tbody>
</table>

If you use a Macintosh computer and:
- Printing takes a long time.
- Collated printing or non collated printing cannot be performed.
- Printing with the specified printing conditions cannot be performed.
- A checkmark is displayed at "Collate" in the [Print] dialog box of application software.

Clear the checkmark in the [Print] dialog box of the application software and set [Ejection mode] on the [Main setting] tab in the printer driver screen.

- Orientation of the original data does not match with [Orientation] specified by the printer driver.
- Set the same orientation for [Orientation] of original data created by application software and [Orientation] on the [Layout] tab in the printer driver screen.

The order of pagination is different from the specified order.

When multiple pages of originals are printed, an incorrect paper size is included in output sheets.

- Multiple sizes are included in a set of original data.
- When printing original data including multiple original sizes, all pages are printed onto paper of the size of the first page. Consequently, on a page that has a different size from the first page, incorrect printing such as missing image may occur.
- Also if [Ejection mode] is set to [Collate], collated printing of originals with the same size may occur.

If multiple pages (sheets) of originals are printed with the "collate" setting from Excel, collated printing by page (sheet) is performed.

- The printer driver setting in creating originals is not correct.
- When creating multiple pages (sheets) of originals, select the printer in advance. All pages are printed with the paper size and other output settings for the first sheet. If you create data of multiple pages (sheets) by using another printer driver, set [Print quality] for all pages (sheets) to [300dpi] in the [Page Setup] screen of application software (Excel).

Colours different from specified colors are printed.

- Colour conversion setting is made by application software.
- When printing from application software supplied by Adobe Systems Incorporated, set [Colour profile (*)] to "OFF" from [Advanced] in the [Print] dialog box of the application software.
  * The name and the menu location of "Colour profile" may differ depending on the application.

Images cannot be rotated for printing.

- When printing original data in landscape orientation from Acrobat® or Adobe® Reader, place a checkmark at [Automatic rotation and central arrangement of page] in the Print dialog box.

Enlargement/reduction cannot be performed for printing.

- A checkmark is placed at [Image enlargement/reduction according to paper size] in the [Print] dialog box.
- Remove the checkmark from [Image enlargement/reduction according to paper size] in the [Print] dialog box of Acrobat® and Adobe® Reader. For zooming, set at [Zoom] on the [Layout] tab in the printer driver screen.

Printed size is different from the specified size.

- The paper size in the original data does not match with the output paper size specified by the printer driver.
- Be sure to match the paper size in the original data created by application software with [Output paper size] on the [Layout] tab in the printer driver screen.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stripes appear on images with gradation.</td>
<td>• Dot screen is used for printing. The resolution of the printer is 300 dpi. Set [Screen frequency (lpi)] to [70 lpi] and execute printing again.</td>
</tr>
<tr>
<td>Browsing/storing account record from Mac OS X</td>
<td>• <strong>Browsing/storing account record from Mac OS X</strong> Click [Help] in the RISO Console PS7R screen. The account record can be checked from [Account record] of [Custom setting]. [Store in folder] allows the account record to be stored with tab delimiters as a text file. Although a warning message may appear when you try to store, the data is stored.</td>
</tr>
</tbody>
</table>

The setting items may vary depending on the OS and application software. Refer to the help in each screen and Read Me of the software.
### Other Trouble

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplex printing cannot be performed.</td>
<td>&quot;Duplex printing&quot; is not set in the printer driver screen. Set &quot;Duplex printing&quot; on the [Main setting] tab in the printer driver screen. &quot;Main setting&quot; ( \Rightarrow ) p.2-5 ( \Rightarrow ) p.3-5</td>
</tr>
<tr>
<td>• Collated printing or non collated printing cannot be performed. • Page order is not normal. • Preset number of copies is exceeded.</td>
<td>In the [Print] dialog box of application software, a checkmark is displayed at &quot;Collate.&quot; Clear the checkmark in the [Print] dialog box of application software and set &quot;Ejection mode&quot; on the [Main setting] tab in the printer driver screen. &quot;Ejection mode&quot; ( \Rightarrow ) p.2-8 ( \Rightarrow ) p.3-8</td>
</tr>
<tr>
<td>A multiple number of copies (sheets) is set but only one copy (sheet) can be printed.</td>
<td>&quot;Proof copy&quot; is set. Since &quot;Proof copy&quot; is set on the [Main setting] tab in the printer driver screen, printing stops after one copy. To continue printing, press the PRINT/PAUSE Key on the Operation Panel. If proof copy is not required, clear the checkmark at &quot;Pause after a proof.&quot; ( \Rightarrow ) p.2-8 ( \Rightarrow ) p.3-8</td>
</tr>
<tr>
<td>The orientation of print is automatically changed.</td>
<td>The orientation may be automatically changed depending on the application software. If [Special image setting] on the [Layout] tab in the printer driver screen is set to &quot;0&quot; of image rotation angle, the orientation of printing specified by the application software can be seen. From this printing result, specify the desired image rotation angle. ( \Rightarrow ) p.2-23 ( \Rightarrow ) p.3-23</td>
</tr>
<tr>
<td>A font other than specified is used for printing.</td>
<td>A font that is not provided in the printer is used. A font that is not provided in the printer is automatically replaced with a provided font for printing.</td>
</tr>
<tr>
<td>A part of print image is missing.</td>
<td>The [Paper size] and [Paper type] settings in the printer driver screen do not match those of the menu setting. Select the same settings at [Paper size] and [Paper type] in the printer driver screen and in the printer menu setting. An improper enlargement/reduction ratio is specified. The zoom setting on the [Layout] tab in the printer driver screen is not correct. Select the correct ratio. &quot;Zoom&quot; ( \Rightarrow ) p.2-12 ( \Rightarrow ) p.3-12</td>
</tr>
<tr>
<td>Characters and lines are serrated.</td>
<td>Place a checkmark at &quot;Line smoothing&quot; on the [Image processing] tab in the printer driver screen. ( \Rightarrow ) p.2-22 ( \Rightarrow ) p.3-21</td>
</tr>
<tr>
<td>The colours of the images such as photo are different from those on the display.</td>
<td>The colour control method is different between the display and the printer. Since colours are expressed with RGB on the display and with CMYK in the printer, colour tones are different. Also the difference is generated from the performance of the computer and the display. Perform &quot;Gamma control&quot; on the [Image processing] tab in the printer driver screen or adjust the display. ( \Rightarrow ) p.2-18 ( \Rightarrow ) p.3-18</td>
</tr>
<tr>
<td>The printer driver setting does not fit the file format for photo.</td>
<td>The printer driver setting does not fit the file format for photo. Select &quot;Auto colour matching&quot; at [Special image setting] on the [Image processing] tab in the printer driver screen according to the file format for photo. ( \Rightarrow ) p.3-24</td>
</tr>
<tr>
<td>The screen of RISO Console is not displayed</td>
<td>The printer IP address setting is not correct. Check the correct IP address and input it. “5.7 Network Configuration” of “HC5500 User’s Manual for Printer Main Body” ( \Rightarrow ) p.2-44</td>
</tr>
</tbody>
</table>
Chapter 6  Appendix
<table>
<thead>
<tr>
<th>Font Name</th>
<th>Font Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AdobeSerifMM</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>ArialMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AntiqueOlive-Compact</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Apple-Chancery</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Arial-BoldMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AvantGarde-BookOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AlbertusMT-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AdobeSansMM</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AlbertusMT-Light</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AlbertusMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AvantGarde-Book</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Clarendon-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Carta</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AvantGarde-DemiOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AntiqueOlive-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni-PosterCompressed</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AntiqueOlive-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AntiqueOlive-Roman</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Arial-BoldItalicMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Arial-ItalicMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>AvantGarde-Demi</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni-Poster</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Chicago</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Copperplate-ThirtyThreeBC</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bodoni-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Clarendon-Light</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Eurostile-BoldExtendedTwo</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bookman-DemiItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bookman-LightItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bookman-Demi</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>CooperBlack-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Bookman-Light</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Clarendon</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Coronet-Regular</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Courier-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Geneva</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>CooperBlack</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Goudy-ExtraBold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Goudy</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Copperplate-ThirtyTwoBC</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Narrow-BoldOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Eurostile-ExtendedTwo</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Condensed-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Courier-BoldOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Courier-Oblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Eurostile</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Eurostile-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>HoeflerText-Black</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Font Name</td>
<td>Text</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>JoannaMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Consoled-BoldObl</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-BoldCondensed</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-LightItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-Condensed</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-Light</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>GillSans-ExtraBold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Goudy-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Consoled-Oblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-BoldOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Goudy-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Goudy-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Narrow-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Condensed</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Narrow</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Marigold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>JoannaMT-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Monaco</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Optima-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>NewYork</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>StempelGaramond-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>HoeflerText-Regular</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>JoannaMT-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LetterGothic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Optima</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Helvetica-Narrow-Oblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>HoeflerText-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Palatino-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Times-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Oxford</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LetterGothic-BoldSlanted</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>HoeflerText-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LubalinGraph-BookOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>HoeflerText-Ornaments</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>JoannaMT-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LetterGothic-Final</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LubalinGraph-DemiOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LetterGothic-Slanted</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LubalinGraph-Book</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>NewCenturySchlbk-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>LubalinGraph-Demi</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>MonaLisa-Recut</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Optima-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Palatino-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>StempelGaramond-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Optima-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Palatino-Roman</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Symbol</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>NewCenturySchlbk-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Tekton</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Font Style</td>
<td>Text</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>NewCenturySchlbk-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>NewCenturySchlbk-Roman</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>StempelGaramond-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>StempelGaramond-Roman</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Palatino-BoldItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Times-Bold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Times-Italic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Times-Roman</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>TimesNewRomanPS-BoldItalicMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>TimesNewRomanPSMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-CondensedBoldOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>TimesNewRomanPS-ItalicMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>TimesNewRomanPS-BoldMT</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-CondensedBold</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-BoldExt</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-BoldExtOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-BoldOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-Condensed</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-CondensedOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-Extended</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-ExtendedObl</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-Light</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-LightOblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Univers-Oblique</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Wingdings-Regular</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>ZapfChancery-MediumItalic</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>ZapfDingbats</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
<tr>
<td>Wingdings</td>
<td>The quick brown fox jumps over the lazy dog</td>
</tr>
</tbody>
</table>
### Numerics

<table>
<thead>
<tr>
<th>Numerics</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-fold</td>
<td>4-11</td>
</tr>
</tbody>
</table>

### A

<table>
<thead>
<tr>
<th>A</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A unit of length</td>
<td>2-31</td>
</tr>
<tr>
<td>[About..] tab</td>
<td>2-4, 3-4</td>
</tr>
<tr>
<td>About</td>
<td>2-34, 3-37</td>
</tr>
<tr>
<td>Add</td>
<td>2-28</td>
</tr>
<tr>
<td>Add cover</td>
<td>4-2, 4-3</td>
</tr>
<tr>
<td>Additional engine memory</td>
<td>2-31</td>
</tr>
<tr>
<td>Adobe PS</td>
<td>1-19</td>
</tr>
<tr>
<td>[Advanced] tab</td>
<td>3-4</td>
</tr>
<tr>
<td>Archive</td>
<td>3-9</td>
</tr>
<tr>
<td>ATM</td>
<td>1-22</td>
</tr>
<tr>
<td>Auto colour matching</td>
<td>3-22, 3-24</td>
</tr>
<tr>
<td>Auto tray selection</td>
<td>2-7, 3-7</td>
</tr>
</tbody>
</table>

### B

<table>
<thead>
<tr>
<th>B</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between Jobs</td>
<td>2-26, 3-25</td>
</tr>
<tr>
<td>Binding margin</td>
<td>4-8</td>
</tr>
<tr>
<td>Booklet</td>
<td>2-14, 3-14, 4-2, 4-5</td>
</tr>
</tbody>
</table>

### C

<table>
<thead>
<tr>
<th>C</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centre binding margin</td>
<td>4-6</td>
</tr>
<tr>
<td>Chroma</td>
<td>2-19</td>
</tr>
<tr>
<td>Close</td>
<td>2-10</td>
</tr>
<tr>
<td>Clustering</td>
<td>3-25, 3-26</td>
</tr>
<tr>
<td>Collate</td>
<td>2-8, 3-8</td>
</tr>
<tr>
<td>Colour</td>
<td>2-5, 3-5</td>
</tr>
<tr>
<td>Colour Management</td>
<td>2-6, 3-6, 3-24</td>
</tr>
<tr>
<td>Colour mode</td>
<td>2-5, 3-5</td>
</tr>
<tr>
<td>Colour profile</td>
<td>2-34</td>
</tr>
<tr>
<td>Contrast</td>
<td>2-19, 3-19</td>
</tr>
<tr>
<td>Custom size entry</td>
<td>2-31</td>
</tr>
</tbody>
</table>

### D

<table>
<thead>
<tr>
<th>D</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>2-10, 2-28, 2-29</td>
</tr>
<tr>
<td>Density</td>
<td>3-19</td>
</tr>
<tr>
<td>Details of Add cover</td>
<td>4-3</td>
</tr>
<tr>
<td>Details of Booklet</td>
<td>4-6</td>
</tr>
<tr>
<td>Details of Paper Fold</td>
<td>4-12</td>
</tr>
<tr>
<td>Details of Stapler/Punching</td>
<td>4-8, 4-9</td>
</tr>
<tr>
<td>Direct print</td>
<td>2-9, 3-9</td>
</tr>
<tr>
<td>Dot screen</td>
<td>2-21, 3-20</td>
</tr>
<tr>
<td>Dot screen setting</td>
<td>3-21</td>
</tr>
<tr>
<td>Double side overlay</td>
<td>3-29, 3-30</td>
</tr>
<tr>
<td>Duplex printing</td>
<td>2-5, 2-6, 3-5, 3-6</td>
</tr>
</tbody>
</table>

### E

<table>
<thead>
<tr>
<th>E</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>2-28, 2-29</td>
</tr>
<tr>
<td>Ejection mode</td>
<td>2-5, 2-8, 3-5, 3-8</td>
</tr>
<tr>
<td>[Environment] tab</td>
<td>2-3, 3-3</td>
</tr>
</tbody>
</table>

### Environment

<table>
<thead>
<tr>
<th>Environment</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Diffusion</td>
<td>2-21, 3-20</td>
</tr>
<tr>
<td>Every Division</td>
<td>2-26, 3-25</td>
</tr>
</tbody>
</table>

### F

<table>
<thead>
<tr>
<th>F</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Tray 1</td>
<td>2-7, 3-7</td>
</tr>
<tr>
<td>Feed Tray 2</td>
<td>2-7, 3-7</td>
</tr>
<tr>
<td>Fine</td>
<td>2-25, 3-24</td>
</tr>
<tr>
<td>[Finisher] tab</td>
<td>2-3, 3-3</td>
</tr>
<tr>
<td>Finisher</td>
<td>4-1, 4-2</td>
</tr>
<tr>
<td>Fold</td>
<td>3-14, 4-5</td>
</tr>
<tr>
<td>Fold and staple</td>
<td>4-5</td>
</tr>
<tr>
<td>Folder security code</td>
<td>3-10</td>
</tr>
<tr>
<td>Folding direction</td>
<td>4-12</td>
</tr>
<tr>
<td>Font</td>
<td>6-2</td>
</tr>
<tr>
<td>Form</td>
<td>2-9, 3-9</td>
</tr>
<tr>
<td>Form data print face</td>
<td>3-29, 3-32</td>
</tr>
<tr>
<td>Form list</td>
<td>3-29</td>
</tr>
<tr>
<td>Form preview</td>
<td>3-29</td>
</tr>
<tr>
<td>Form print pattern</td>
<td>3-29, 3-30</td>
</tr>
<tr>
<td>[Forms] tab</td>
<td>3-3</td>
</tr>
<tr>
<td>Forms</td>
<td>3-29</td>
</tr>
</tbody>
</table>

### G

<table>
<thead>
<tr>
<th>G</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamma control</td>
<td>2-18, 2-20, 3-18, 3-19</td>
</tr>
<tr>
<td>Gamma Value</td>
<td>2-18, 3-18</td>
</tr>
</tbody>
</table>

### H

<table>
<thead>
<tr>
<th>H</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Half Tone</td>
<td>2-21, 3-20</td>
</tr>
<tr>
<td>How to Print a Form</td>
<td>3-34</td>
</tr>
</tbody>
</table>

### I

<table>
<thead>
<tr>
<th>I</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image position adjustment</td>
<td>2-23, 2-24, 3-22, 3-23</td>
</tr>
<tr>
<td>[Image processing] tab</td>
<td>2-2, 3-2</td>
</tr>
<tr>
<td>Image processing</td>
<td>2-18, 3-18</td>
</tr>
<tr>
<td>Image quality</td>
<td>2-23, 2-25, 3-22, 3-24</td>
</tr>
<tr>
<td>Image rotation</td>
<td>2-23, 2-24, 3-22, 3-23</td>
</tr>
<tr>
<td>Install</td>
<td>1-6, 1-13, 1-20</td>
</tr>
<tr>
<td>IP Address</td>
<td>v</td>
</tr>
</tbody>
</table>

### J

<table>
<thead>
<tr>
<th>J</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job comment</td>
<td>2-9, 3-10</td>
</tr>
<tr>
<td>Job delegation</td>
<td>3-26</td>
</tr>
<tr>
<td>Job name is not indicated on Job Manager.</td>
<td>2-27, 3-28</td>
</tr>
<tr>
<td>Job Separation</td>
<td>2-26, 3-25</td>
</tr>
<tr>
<td>Job split</td>
<td>3-26</td>
</tr>
<tr>
<td>Job split limit</td>
<td>3-26</td>
</tr>
</tbody>
</table>

### L

<table>
<thead>
<tr>
<th>L</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN cable</td>
<td>iv</td>
</tr>
<tr>
<td>Landscape</td>
<td>2-13, 3-13</td>
</tr>
<tr>
<td>[Layout] tab</td>
<td>2-2, 3-2</td>
</tr>
<tr>
<td><strong>M</strong></td>
<td><strong>N</strong></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Mac OS9</td>
<td>Name</td>
</tr>
<tr>
<td>Mac OS X</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Print & Storage**
- 2-9, 3-9
- Printer config...
- 2-31, 3-36
- Printer Driver
- 1-1
- Printer Driver Operation
- 2-1, 3-1
- Punching
- 4-2, 4-9
- Punching hole
- 4-8
- Put back cover
- 4-4
- Put front cover
- 4-4

**RISO Wakeup Tool**
- 1-29

**Save**
- 2-10

**Screen frequency**
- 2-18, 2-22, 3-18, 3-21

**Screening**
- 2-18, 2-21, 3-18, 3-20

**Security Code**
- 2-27, 3-28

**Security print**
- 2-26, 2-27, 3-25, 3-28

**Select back cover tray**
- 4-4

**Select front cover tray**
- 4-4

**Separate books**
- 4-6

**Short edge binding**
- 3-6, 4-6

**Single + Double side overlay**
- 3-30

**Single side overlay**
- 3-30

**Single side print + staple ->Speed priority**
- 2-31

**Special setting**
- 2-18, 2-23, 3-18, 4-22

**Specify Front and Back respectively**
- 3-29

**Specify output condition**
- 2-5, 2-9, 3-5, 3-10

**Specify the page**
- 2-28

**Stacking Tray**
- 4-10

**Standard**
- 2-25, 3-24

**Standard Feed Tray**
- 2-7, 3-7

**Stapler**
- 4-2, 4-7

**Storage**
- 2-9, 3-9

**Storage folder name**
- 2-9, 3-10

**T**
- Tab
- 2-2, 2-3, 2-4, 3-2, 3-3, 3-4

**U**
- Uninstall
- 1-8, 1-15

**V**
- Version
- 2-34

**W**
- [Watermark] tab
- 2-3

**Watermark**
- 2-28

**Z**
- Zoom
- 2-11, 2-12, 3-11, 3-12